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Introducing Inventory
Solution

This chapter includes the following topics:

■ About Inventory Solution

■ About Inventory Pack for Servers

■ About licensing Inventory Solution

■ About Cloud-enabled Management

■ About gathering inventory in the Cloud-enabled Management environment

■ Components of Inventory Solution

■ What you can do with Inventory Solution

■ Methods for gathering inventory

■ About inventory performance tuning

■ Where to get more information

About Inventory Solution

Note: Current documentation applies to the most recent version of the product.

Inventory Solution lets you gather inventory data about computers, users, operating systems,
and installed software applications in your environment. The application metering feature also
lets you monitor and deny the usage of software applications on your network.

1Chapter



Note: You can track usage of managed software products, meter, and deny Win64 and Win32
applications on Windows XP and above client computers only.

You can track usage of managed software products on Mac client computers.

Software-based usage tracking and application metering are not supported on Windows and
Mac servers.

See “Components of Inventory Solution” on page 17.

Inventory Solution lets you gather inventory on Windows, UNIX, Linux, and Mac computers.

Note: For gathering all inventory data, Perl version 5.6 or later must be installed on your UNIX,
Linux, and Mac computers. $PATH environment variable must have the correct reference to
Perl location.

Policies and tasks let you gather inventory and perform application metering. You can use
predefined inventory policies, configure them, or create new policies and tasks according to
your needs.

See “About inventory policies and tasks ” on page 46.

See “About predefined inventory policies” on page 47.

The inventory data is stored in the Configuration Management Database (CMDB). The CMDB
provides a central store of data that is used across the Symantec Management Platform.

For more information, see the topics about the CMDB in the IT Management Suite Administration
Guide.

You can gather the following types of inventory data:

Computer name, domain, installed operating system, etc.Basic inventory data

Hardware and software components, file properties, etc.Standard inventory data

Additional data beyond the predefined data classes in Inventory Solution.Custom inventory data

Start, stop, deny events and summary data of monitored Windows software
applications.

Summary data of monitored Mac software applications.

Application metering
inventory data

Information about files and registry settings on Windows computers.Baseline inventory data

Inventory data from the discovered devices in your network.Inventory for Network
Devices

See “Methods for gathering inventory” on page 20.
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Inventory Solution provides a web-based management console, policies to alert you about
critical information, and predefined or custom reports that let you analyze gathered inventory
data.

See “About viewing inventory data” on page 142.

Inventory Solution also has the following features:

■ Supports zero-footprint configuration.

■ Operates in always connected, sometimes connected, and standalone computing
environments.

■ Can be installed to run on a recurring basis with the Symantec Management Agent.

■ Posts data through SMB and/or HTTP.

■ Lets you meter, track, or deny the usage of one or more software applications and harvest
unused software licenses.

See “What you can do with Inventory Solution” on page 19.

Inventory Pack for Servers is a separate product that lets you gather server-based inventory
data from servers.

See “About Inventory Pack for Servers ” on page 11.

Additional Symantec products let you gather inventory data from managed computers, network
devices, and Windows, UNIX, Linux, and Mac servers.

See “Where to get more information” on page 32.

About Inventory Pack for Servers
Inventory Pack for Servers is a separate product with a separate license. It runs on top of
Inventory Solution and uses the Inventory Pack for Servers Plug-in. Inventory Pack for Servers
lets you gather inventory on Windows, UNIX and Linux computers.

Inventory Pack for Servers is part of the Server Management Suite.

You can use different methods to gather inventory data about server-class software that is
installed on servers.

See “Methods for gathering inventory” on page 20.

Server Inventory is supported for the following server applications:

■ Oracle Database 9i (Enterprise Edition, Standard Edition)

■ Oracle Database 10g (Enterprise Edition, Standard Edition, Standard Edition One)

■ Oracle Database 11g (Enterprise Edition, Standard Edition, Standard Edition One)
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Note:For Oracle, only standalone server configurations are supported. Distributed configuration
modes (such as Application Cluster, Oracle Streams, Oracle Dataguard, Oracle Standby
Database, etc.) are not supported.

Note: Inventory Solution and Inventory Pack for Servers support Ubuntu (versions 14.04 LTS,
16.04 LTS, and 17.04). However, server inventory data may not be properly gathered for
Oracle server database on the client computers that run Ubuntu. The reason for this limitation
is that Oracle Corporation does not officially support Ubuntu for Oracle database.

Note: Oracle does not provide official Oracle database packages for Ubuntu.

■ Microsoft SQL Server 2008

■ Microsoft SQL Server 2012

■ Microsoft SQL Server 2014

■ Microsoft SQL Server 2016

■ Microsoft SQL Server clusters

■ Microsoft Exchange Server

■ Microsoft DHCP server

■ Microsoft DNS server

■ Microsoft RAS server

■ Microsoft IIS

■ MySQL 5.7.x (not supported for Windows)

■ Apache HTTP Server 2.x

■ Network load balancing

■ System DSN

Note: Only the servers that are installed as a native package into the default directories are
supported.

When creating an Inventory task, the Administrator needs to provide credentials to connect to
the database, otherwise inventory only collects limited information.

For a complete list of supported platforms and versions, see release notes at the following
URL:
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http://www.symantec.com/docs/DOC9471

See “About Inventory Solution” on page 9.

About licensing Inventory Solution
Each Symantec product includes a trial license that is installed by default.

You can also purchase a full product license.

Use the Symantec Installation Manager to install licenses.

For more information about applying licenses to a solution, see the IT Management Suite
Installation and Upgrade Guide

Altiris™ Inventory for Network Devices from Symantec™ is a part of Inventory Solution and
shares licenses with Inventory Solution if you install the solutions within any of the following
suites:

■ Symantec™ Client Management Suite powered by Altiris™ technology

■ Symantec™ Server Management Suite powered by Altiris™ technology

■ Symantec™ IT Management Suite powered by Altiris™ technology

See “About Inventory for Network Devices” on page 66.

Symantec™ Inventory Pack for Servers powered by Altiris™ technology is a separate product.
You need to purchase a separate license for it.

You start to consume a license after Notification Server receives the first standard, custom,
application metering, baseline, or server inventory data from managed computers.

A license is not consumed in the following situations:

■ When the Inventory plug-in exists on a managed computer but does not collect and report
to Notification Server any Inventory Solution data.

■ When the Symantec Management Agent collects only basic inventory.
For more information about the basic inventory and the Symantec Management Agent,
see the IT Management Suite Administration Guide.

See “Methods for gathering inventory” on page 20.

After you exceed your client license limit, you continue to receive inventory data from licensed
assets. Incoming inventory data from unlicensed assets is discarded.

When the trial or other temporary licenses expire, the following events occur:

■ Inventory plug-in rollouts continue to function without any problems.

■ All new incoming inventory data is discarded.
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After AUP expiration, all functions continue to work normally. However, if you install newer
versions of the solution, their functionality is not maintained.

If you use Inventory Solution 8.0 or later, the following actions release a license:

■ Setting an asset to any other state except active.

Note: Inventory Solution data and all associations with this resource inventory data are
purged for retired, returned to lessor, and disposed assets.

The asset history of retired assets is maintained for reporting and auditing purposes.

■ Deletion of the computer resource record.

Table 1-1 Asset status change influence on licensing and other behavior of Inventory
Solution 8.0 or later

Does
Notification
Server change
the status to
active upon
receiving
Inventory
Solution data?

Does
Notification
Server change
the status to
active upon
receiving a
basic inventory?

Does
Notification
Server respond
to a
configuration
request?

Does
Notification
Server delete
the Inventory
Solution data
that is already
in thedatabase?

Is an Inventory
license released
when you
change the
asset status
from Active to
this status?

Asset status

YesYesYesYesYesDisposed

NoYesYesNoYesIn Stock

NoYesYesNoYesMissing

NoYesYesNoYesOn Order

YesYesYesYesYesRetired

YesYesYesYesYesReturned to
Lessor

NoYesYesNoYesRMA

NoYesYesNoYesAny custom
status
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Table 1-1 Asset status change influence on licensing and other behavior of Inventory
Solution 8.0 or later (continued)

Does
Notification
Server change
the status to
active upon
receiving
Inventory
Solution data?

Does
Notification
Server change
the status to
active upon
receiving a
basic inventory?

Does
Notification
Server respond
to a
configuration
request?

Does
Notification
Server delete
the Inventory
Solution data
that is already
in thedatabase?

Is an Inventory
license released
when you
change the
asset status
from Active to
this status?

Asset status

Yes

A basic inventory
is sent as a part of
the configuration
request. A new
resource with
Active status is
created.

Yes

A basic inventory
is sent as a part of
the configuration
request. A new
resource with
Active status is
created.

Yes

A basic inventory
is sent as a part of
the configuration
request. A new
resource with
Active status is
created.

YesYesThe computer
resource record is
deleted

See “About Inventory Solution” on page 9.

About Cloud-enabled Management
Cloud-enabled Management lets you manage the client computers over Internet even if the
management servers cannot be accessed directly. The client computers can then be managed
if they are outside of the corporate environment. The managed computers do not need to use
a VPN connection to your organization's network.

Possible scenarios where Cloud-enabled Management can be applied are: organizations that
have many employees traveling or working outside of the office, highly distributed companies,
or managed service providers.

When Cloud-enabled Management is implemented, the Symantec Management Agent
communicates with the Notification Server computer and the site servers through an Internet
gateway. The Notification Server computer and site servers are therefore protected and not
directly exposed to the Internet. The agent automatically determines whether routing the
communication through the Internet gateway is needed or if it can connect directly to the local
network.

Note: Cloud-enabled Management is only supported on Microsoft Windows and Mac client
computers.
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For more information about Cloud-enabled Management, see the IT Management Suite
Administration Guide.

About gathering inventory in the Cloud-enabled
Management environment

Cloud-enabled Management lets you manage computers over Internet even if you cannot
access the management servers directly. You can manage the computers if they are outside
of the corporate environment. The managed computers do not need to use a VPN connection
to your organization's network.

See “About Cloud-enabled Management” on page 15.

Note: Cloud-enabled Management is only supported on Windows and Mac computers.

In the Cloud-enabled Management environment, you can use the following methods for
gathering inventory data:

■ Basic inventory

■ Standard inventory on managed computers
See “Gathering inventory on managed computers” on page 40.

■ Custom inventory
See “About gathering custom inventory” on page 77.

■ Server inventory
See “About Inventory Pack for Servers ” on page 11.

■ Application metering
See “About software usage tracking, application metering, and application denial”
on page 103.

The following components of Inventory Solution and methods for gathering inventory data are
not supported in the Cloud-enabled Management environment:

■ Standalone inventory
See “About gathering inventory using stand-alone packages” on page 56.

■ Baseline inventory
See “About baseline inventory” on page 134.

■ Inventory for Network Devices
See “About Inventory for Network Devices” on page 66.

See “Methods for gathering inventory” on page 20.

See “Components of Inventory Solution” on page 17.
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Components of Inventory Solution
Inventory Solution provides the following components and tools to help you perform inventory
tasks.

Table 1-2 Components of Inventory Solution

DescriptionComponent

The following plug-ins work with the Symantec Management Agent to gather inventory
on the managed computers and communicate with Notification Server.

■ Inventory Plug-in
This plug-in lets you gather inventory data on managed computers.

■ Application Metering Plug-in
This plug-in lets you track software usage on managed Windows and Mac
computers. It also lets you meter or deny applications on managed Windows
computers.

■ Inventory Pack for Servers Plug-in
If you have Inventory Pack for Servers running on top of Inventory Solution, you
can gather server-based inventory data from managed server computers.
See “About Inventory Pack for Servers ” on page 11.

Inventory plug-ins

Inventory policies let you gather inventory from managed computers at scheduled
intervals. You can create and manage inventory policies from the Symantec
Management Console.

Symantec recommends that you use inventory policies instead of tasks for recurring
inventory activities.

See “Methods for gathering inventory” on page 20.

Inventory policies and tasks

This portal page provides links to commonly used inventory tasks and a summary of
inventory data and inventory policy status.

Inventory portal page

Predefined inventory reports let you view and analyze the gathered inventory data.
You can also create custom reports.

See “About viewing inventory data” on page 142.

Inventory reports

You can collect inventory on the computers that are not managed through the Symantec
Management Platform. You can create and run the executables that gather inventory
data and report it to the Configuration Management Database (CMDB). You can deliver
these executables through login scripts, USB keys, network shares, etc.

See “About gathering inventory using stand-alone packages” on page 56.

Standalone inventory
executables

(Windows only)
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Table 1-2 Components of Inventory Solution (continued)

DescriptionComponent

Inventory Solution gathers inventory data for hundreds of predefined data classes. You
can expand and customize the types of data that you want to collect. For example, you
can add specific registry data or specific hardware components.

See “About gathering custom inventory” on page 77.

Custom inventory

You can gather inventory about the software applications that are installed in your
environment.

You can use the following software inventory methods:

■ Basic application file inventory.
■ Add or Remove Programs list and UNIX/Linux/Mac software packages.
■ Targeted software inventory on Windows computers and software inventory using

the filescan.rule file on UNIX, Linux, and Mac computers.
■ Validating gathered software inventory data with the Software Catalog Data Provider.

See “About gathering software inventory” on page 86.

Software inventory

Inventory Solution lets you perform the following tasks on your managed computers:

■ Track usage of the managed Mac software at the software product and component
level.
Track usage of the managed Windows software at the software product, component,
and file level.
This task is the primary method to use for the majority of software products.

■ (Windows only)
Meter the use and control the availability of applications by running predefined or
custom application metering policies.
Symantec recommends that you use this task only if you need to meter start, stop,
and denial events for applications at the file level.

■ (Windows only)
Deny multiple applications from running by configuring the predefined Blacklisted
Applications policy or running custom application metering policies.

See “About software usage tracking, application metering, and application denial”
on page 103.

Software-based usage
tracking and application
metering

(Windows and Mac only)

You can determine how the inventory data from a client computer is compared to a
baseline. You can detect how this data has changed over time, and see the differences
between a target computer and a baseline computer.

See “About baseline inventory” on page 134.

Baseline inventory

(Windows only)
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Table 1-2 Components of Inventory Solution (continued)

DescriptionComponent

You can use the Software Catalog Data Provider (SCDP) to identify the software that
has been detected on the client computers in your environment and that cannot be
identified otherwise.

The SCDP provides a list of known applications and predefined software products that
is imported into the CMDB. The SCDP helps you identify the detected software and
create a software resource for it in the Software Catalog. By default, most of the SCDP
components function automatically.

See “About Software Catalog Data Provider” on page 98.

Software Catalog Data
Provider

(Windows only)

Inventory for Network Devices is a part of Inventory Solution and shares licenses with
Inventory Solution if you install the solutions within any of the following suites:

■ Symantec™ Client Management Suite powered by Altiris™ technology
■ Symantec™ Server Management Suite powered by Altiris™ technology
■ Symantec™ IT Management Suite powered by Altiris™ technology

Inventory for Network Devices gathers inventory data from the discovered devices in
your network. This inventory is gathered from the devices that are not managed through
the Symantec Management Agent. Because a management agent is not required, this
inventory is considered an agentless inventory.

See “About Inventory for Network Devices” on page 66.

Altiris™ Inventory for Network
Devices from Symantec™

What you can do with Inventory Solution
The Symantec Management Platform gathers basic inventory from managed computers.
Inventory Solution lets you gather more specific inventory data using different methods.

You can use standard and custom inventory data to do the following:

■ Obtain an up-to-date inventory of the computers in your network and their operating system
platforms.

■ Identify the computers that do not meet minimum security requirements, such as application
updates, management agents, and so on.

■ Determine which computers need to be replaced according to age or capabilities.

■ Identify the types and amounts of personal data that is stored on computers, such as .MP3

files, .MPG files, and so on.

■ Prepare for operating system migrations by doing the following:

■ Identifying the number of different operating systems that are installed.
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■ Identifying the computers that do and do not meet minimum hardware requirements for
a new operating system.

■ Identifying the users of computers to be migrated.

■ Determining which applications need to be re-deployed after the migration.

You can use application metering inventory data to do the following:

■ Prepare for a software license audit by providing the number of installed instances of an
application.

■ Deny unauthorized applications from running on managed computers.

■ Manage your application licenses by tracking how often an application is used, not only if
it is installed.

You can use baseline inventory data to compare the files or registry settings of managed
computers against a baseline.

See “Methods for gathering inventory” on page 20.

See “About Inventory Solution” on page 9.

Methods for gathering inventory
You can use different methods for gathering different types of inventory data. Each method
has special features and requirements.
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Table 1-3 Methods for gathering inventory

Features and requirementsDescriptionMethod

The features are as follows:

■ Inventory data is automatically collected
when the Symantec Management
Agent is installed on the client
computer. No other components or
steps are needed.

■ Inventory data is updated at regular
intervals.

■ You can use this method on different
platforms.

■ You can use this method for gathering
inventory data on managed Windows
computers in the Cloud-enabled
Management environment.

The requirements are as follows:

■ Target computers must be managed
using the Symantec Management
Agent.

Note: Basic inventory data is limited in
scope.

The basic inventory is gathered
automatically when the Symantec
Management Agent is installed on
managed computers. This feature is a core
function of the Symantec Management
Platform and does not require any
additional inventory components.

Basic inventory data includes computer
name, domain, installed operating system,
MAC and IP address, primary user
account, etc. This information is updated
on a regular basis as long as the Symantec
Management Agent is running on the
computer.

For more information, see the topics about
the Symantec Management Agent and
recommended Symantec Management
Agent data update intervals in the IT
Management Suite Administration Guide.

Basic inventory
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

Inventory Plug-in works with the Symantec
Management Agent and uses scheduled
policies to gather standard inventory data
that is more detailed than basic inventory.
By default, standard inventory data is
gathered through more than 100
predefined data classes.

Standard inventory data includes the
following details about managed
computers:

■ Hardware components, operating
system, and user accounts and groups.

■ Software and virtual software layers.
■ File properties.

More detailed information about the
software, such as manufacturer,
version, size, etc.

See “About gathering software inventory”
on page 86.

When Inventory Plug-in is installed on
managed computers, you can manage all
the inventory policies from the Symantec
Management Console. You can schedule
inventory policies to run at regular intervals
according to your needs, so that gathering
inventory does not affect your network
performance.

You can use Inventory Plug-in on
Windows, Linux, UNIX, and Mac platforms.

Standard inventory on
managed computers
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

The features are as follows:

■ You can gather a broad range of
inventory data.

■ Inventory data is automatically collected
and updated using scheduled policies
and tasks.

■ You can gather the most important
inventory data frequently during a day.
You can also gather software inventory
on Windows computers in real time.
See “About predefined inventory
policies” on page 47.

■ You can configure policies to report
only the data that has changed since
the last full inventory scan (delta
inventory).

■ Inventory Solution automatically detects
the computers with data discrepancies
and maintains the inventory data
consistency without overloading your
environment.
See “About inventory performance
tuning” on page 28.

■ This method can be used on multiple
platforms.

■ You can gather standard inventory on
managed Windows and Mac computers
in the Cloud-enabled Management
environment.

The requirements are as follows:

■ Target computers must be managed
using the Symantec Management
Agent.

Note: Maintaining current inventory
data can be difficult on the computers
that are not regularly connected to the
network.

■ Target computers must have Inventory
Plug-in installed.
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

Note: The scope of inventory information
that is collected depends on your account
permissions.

The features are as follows:

■ You can gather a broad range of
inventory data.

■ Only Windows-based computers are
supported.

The requirements are as follows:

■ External delivery of inventory package
is required.

■ If target computers are not connected
to Notification Server, the data must be
posted manually.

Note: The inventory data is not centrally
managed, and may not be current.

To gather standalone inventory, you must
create stand-alone packages on the
Symantec Management Console. Then
you distribute the packages using email,
network shares, login scripts, etc., and run
the packages on your target computers.

The standalone inventory method lets you
gather standard inventory data on the
computers that are not managed through
the Symantec Management Agent, do not
have Inventory Plug-in installed, and are
not connected to Notification Server

You can gather detailed information about
hardware components, operating system,
local users and groups, software, and
virtual software layers.

You cannot use this method in the
Cloud-enabled Management environment.

See “About gathering inventory using
stand-alone packages” on page 56.

Standalone inventory
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

The features are as follows:

■ You can add the data classes that are
unique to your environment, and are
not included by default.

■ You can use a sample script task to
create or configure a custom inventory
script task.

■ This method can be used on different
platforms.

■ You can use this method for gathering
inventory data on managed Windows
computers in the Cloud-enabled
Management environment.

The requirements are as follows:

■ Target computers must be managed
using the Symantec Management
Agent.

■ Target Unix, Linux and Mac computers
must have Inventory Plug-in installed.

■ You must create custom inventory data
classes, and include the data classes
in your custom scripts.

■ You must create and run the custom
inventory scripts that collect your
custom inventory data classes.

To gather custom inventory, you must
install Inventory Plug-in on your managed
computers.

This method lets you gather additional data
beyond the predefined data classes in
Inventory Solution. You can create the
custom inventory data classes that may be
unique to your environment. You can then
run the custom inventory scripts that collect
the custom inventory data classes.

See “About gathering custom inventory”
on page 77.

Custom inventory
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

The features are as follows:

■ On Windows computers, you can
control the availability of applications.
You can deny applications from
running. You can also configure deny
events to be sent to Notification Server
when a user tries to run a denied
application.

■ On Windows and Mac computers, the
usage tracking option lets you track
software usage at the product level and
lets you know how often a software is
used, not only if it is installed. This
feature can help you manage your
software licenses.

■ You can use this method for gathering
inventory data on managed Windows
and Mac computers in the
Cloud-enabled Management
environment.

The requirements are as follows:

■ Target computers must be managed
using the Symantec Management
Agent.

■ Target computers must have Inventory
Plug-in and Application Metering
Plug-in installed.

■ Only Windows and Mac client
computers are supported.

Note: This method is not supported on
Windows and Mac servers.

To perform the software-based usage
tracking and application metering, you must
install Inventory Plug-in and Application
Metering Plug-in on your managed
computers.

You can gather the data about application
usage and the summary data of monitored
applications.

You can perform the following tasks on
your managed computers:

■ Track usage of the managed Mac
software at the software product and
component level.
Track usage of the managed Windows
software at the software product,
component, and file level.
This task is the primary method to use
for the majority of software products.

■ (Windows only)
Meter the use and control the
availability of applications by running
predefined or custom application
metering policies.
Symantec recommends that you use
this task only if you need to meter start,
stop, and denial events for applications
at the file level.

■ (Windows only)
Deny multiple applications from running
by configuring the predefined
Blacklisted Applications policy or
running custom application metering
policies.

See “About software usage tracking,
application metering, and application
denial” on page 103.

Software-based usage
tracking and application
metering
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

The features are as follows:

■ You can track the files and registries
that deviate from the corporate
standards.

■ You can verify the accuracy of rollouts
and upgrades.

■ System administrators or the help desk
can get automatic notifications when a
computer is non-compliant.

■ You can view a compliance level
summary of the computer and reports
of the changes in files.

The requirements are as follows:

■ Target computers must be managed
using the Symantec Management
Agent.

■ Only Windows-based computers are
supported.

Note: You cannot use this method in the
Cloud-enabled Management environment.

To gather baseline inventory, you must
install Inventory Plug-in on your managed
computers.

This method lets you gather the data about
files and registry settings on computers.

You can generate a baseline that identifies
the files or registry settings of a computer.
You can later run the compliance scans on
the managed computers to compare their
current files or registry keys with those in
the baseline. The differences between the
baseline scan and compliance scan are
reported to the CMDB.

See “About baseline inventory”
on page 134.

Baseline inventory
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Table 1-3 Methods for gathering inventory (continued)

Features and requirementsDescriptionMethod

The features are as follows:

■ Agentless inventory gathers inventory
on the devices that are already
discovered and exist as resources in
the Configuration Management
Database (CMDB).

The requirements are as follows:

■ Before you gather inventory from
network devices, you must collect the
data about the SNMP-enabled devices
on your network.

■ Before you gather inventory from
network devices, make sure that the
connection profile of the Network
Discovery task has the SNMP turned
on.

Inventory for Network Devices gathers
inventory data from the discovered devices
in your network. This inventory is gathered
from the devices that are not managed
through Symantec Management Agent.
Because a management agent is not
required, this inventory is considered an
agentless inventory.

You can gather inventory on the following
types of devices:

■ Cluster
■ Computer
■ Computer: virtual machine
■ Infrastructure device
■ IP phone
■ KVM device
■ Network-attached storage
■ Network backup device
■ Network printer
■ Physical rack
■ Physical enclosure
■ Physical bay

See “About Inventory for Network Devices”
on page 66.

Inventory for Network Devices

About inventory performance tuning
Inventory Solution lets you gather inventory data about computers, users, operating systems,
and installed software applications in your environment. You can use predefined inventory
policies to collect different types of inventory. You can also modify the predefined policies or
you can create new inventory policies and tasks.

See “About Inventory Solution” on page 9.

Default inventory policy and task settings may overload your network. You can configure
inventory policy and task settings to minimize the effect on your environment. You need to find
the balance between collecting a sufficient amount of inventory data and the resource usage.

Adhering to the following recommendations lets you tune the inventory performance to minimize
the effect on your environment and network workload:
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■ Avoid over scheduling the inventory gathering activities.
On the inventory policy page, you can choose to gather hardware and operating system,
software, file properties, or server applications inventory, according to your needs. All of
these types of inventory do not have to run at the same time. If there are too many inventory
tasks and policies running, it may increase the workload on Notification Server.
Symantec recommends that you use unique policies and schedules for different kinds of
inventory.
For example, you can run full hardware inventory every 4 months, every first Monday, and
delta hardware inventory every 2 months, every second Monday.
Increasing the frequency of an inventory policy or task in an attempt to hit an "online window"
causes redundant data to be sent to Notification Server. The workload on Notification Server
increases as the duplicate data must still be processed and then discarded. Schedule
inventory policies or tasks to occur only at the desired data refresh rate, so that the
Symantec Management Agent can locally manage the inventory collection process.
See “Methods for gathering inventory” on page 20.

■ Use the type and method of gathering inventory that best suits your current needs.
On the inventory policy page, you can choose and configure the type of inventory that you
want to gather. You can also create a custom inventory policy to gather specific data. Using
specific types of inventory lets you reduce network traffic and decrease the workload on
Notification Server.
See “Methods for gathering inventory” on page 20.

■ Use policies instead of tasks for recurring activities.
Symantec recommends that you use policies instead of tasks for recurring inventory
activities.
Inventory policies have more options and allow more flexibility for running regular inventory.
For example, you can schedule an inventory policy to apply to a specific group of users or
computers, and the policy automatically runs on all new computers that you add to the
target group.
See “How inventory policies work” on page 51.

■ Review all inventory tasks before you turn them on.
Inventory tasks have some options enabled by default, which can result in significant
database growth. Symantec recommends that you review the task settings and disable
the options that are not necessary for your specific purpose.

■ Avoid over usage of the Collect Full Inventory policy and its associated inventory task.
Symantec recommends that you run full inventory regularly to minimize the potential for
inventory to get out of synchronization with the server. The default recommendation is to
collect full inventory once a week, but you can configure the policy settings according to
your needs.
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Running full inventory scan too frequently may increase the workload on Notification Server.
To reduce the load on your environment, Symantec recommends that you establish longer
intervals between gathering full inventory, and run delta inventory during those intervals.
Delta inventory reports only the data that has changed since the last full inventory scan.
Running delta inventory helps reduce the network load.
The data in the Configuration Management Database (CMDB) can get outdated if you
make significant changes to the environment, so that the file, hardware, server, or software
inventory data on the client computer is not consistent with the information in the CMDB
anymore. Information inconsistency can occur when the computers are merged, deleted
and then added to Notification Server again, redirected from one Notification Server to
another, or when a new database is used. The inventory data files may also get occasionally
corrupted or not processed by Notification Server.
Inventory Solution helps you automatically detect the computers with data discrepancies
and maintain the inventory data consistency without overloading your environment as
follows:

On managed client and server computers, the predefined NS.Daily task
runs automatically every day at 2:10 A.M. and triggers the hidden Inventory
Inconsistency Detection task that monitors managed computers for
outdated inventory data.

Step 1

If data discrepancy is found, predefined and hidden inventory inconsistency
detection policies run on the relevant computers and do the following:
■ On Windows computers, the policies do not start new inventory scan

but force re-sending to Notification Server the latest available inventory
data that has been collected by the previous scan.

■ On UNIX, Linux, and Mac computers, the policies re-collect the required
inventory data, and then send the data to Notification Server.

Step 2

■ Configure File Properties Scan Settings.
When you configure an inventory policy or task settings, in the Advanced Options dialog
box, review the Files Properties Scan Settings on the following tabs:

By default, all local drives are scanned. You can exclude the drives that you
don't need to scan.

Drives

You can exclude the directories that you don't need to scan.Folders

In the Include file rules dialog box, Symantec recommends that you check
Report size/file count only if you do not need to collect full information about
files. Checking this box lets you decrease the network load.

Files

See “How software inventory rules work” on page 92.
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For more information about the options in the Advanced Options dialog box, click the box
and then press F1.

■ Only enable the Access network file systems (UNIX/Linux/Mac) option if necessary.
Enabling this option in the Advanced Options dialog box may result in getting redundant
inventory data reports.
Scanning remote volumes is disabled by default to prevent numerous computers from
reporting redundant inventory data.

■ Configure the inventory scan throttling option.
Throttling lets you randomize the beginning of the inventory scan, to decrease the network
load.
Symantec recommends that you use throttling in larger environments. For example, when
you have multiple virtual machines on a single physical host computer, running an inventory
scan can result in significant performance issues. Throttling lets you randomize the time
when the inventory scan starts, which effectively randomizes the time when Notification
Server receives the inventory scan results. The network and Notification Server can process
inventory over time.
For example, you can set the scan throttle period to 24 hours. At the scheduled time, the
scan process starts, but then it immediately goes to sleep, and wakes up at some random
time within the specified time period (in this example, 24 hours) to complete the scan.
To enable throttling, on an inventory policy or task page, click Advanced, and then, in the
Advanced Options dialog box, on the Run Options tab, check Throttle inventory scan
evenly over a period of: X hours.
Note that when a policy is executed with this setting, the task is shown as running in the
Task History, even when sleeping for the random amount of time.
See “Creating and configuring inventory policies and tasks” on page 43.

Note: This feature is currently available for Windows only.

■ Configure the System resource usage option.
This option only affects the file scan process, and does not affect the collection of hardware,
operating system, and Add/Remove Programs data.
The System resource usage option lets you define the inventory process priority and thus
modify the usage of the processor and disk on the client computer during an inventory
scan. To determine its value, consider how fast you want the inventory to be gathered and
how the inventory process affects performance of the client computer.
To configure this option, on an inventory policy or task page, click Advanced, and then,
in the Advanced Options dialog box, on the Run Options tab, specify the System
resource usage value according to your needs.
See “Creating and configuring inventory policies and tasks” on page 43.
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On the Windows platform, if you decrease the priority, the process of gathering inventory
requires less resources on the client computer but the inventory scan takes longer. If you
increase the priority, the inventory scan finishes faster but also consumes more resources.
For UNIX, Linux, and Mac computers, the System resource usage value defines the
priority of the inventory process, but does not define the percentage of resource usage.
UNIX, Linux, and Mac computers dedicate more CPU cycles for high priority processes
and fewer CPU cycles for low priority processes. If the computer is in an idle state and runs
only the inventory scan, then low priority process may take the available resources. CPU
usage reduces as soon as another process with a higher priority begins to run.

Note:On the Windows platform, this option is only applicable to file scans. On UNIX, Linux,
and Mac platforms, this option is applicable to the entire inventory scan process.

■ Configure the compression settings.
Using compression lets you compress the data files that managed computers send to
Notification Server. You can specify the minimum file size that is compressed when it is
sent over the network. When you plan to use compression, you need to find the balance
between client and server load, and the network utilization.
If you set the compression threshold at a lower file size, it increases the workload on both
the client computer and Notification Server. The client computer has to compress the file
and the server has to decompress it. However, this setting decreases the network load.
If you set the compression threshold to a higher value, it reduces the workload on the client
computer and the server. However, the network load increases due to the larger files that
are sent over the network.
Symantec recommends that you use compression with smaller files only when you have
a low bandwidth. If your Notification Server serves a site with a high bandwidth, it is not
necessary to use compression.
Compression is automatically enabled for all solutions. To configure the compression
settings, do the following:
In the Symantec Management Console, on the Settings menu, click Agents/Plug-ins >
Targeted Agent Settings. On the Targeted Agent Settings page, on the General tab,
next to the Compress events over box, set the compression threshold according to your
needs.
For more information, see the topics about configuring the targeted agent settings in the
IT Management Suite Administration Guide

Where to get more information
Use the following documentation resources to learn about and use this product.
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Table 1-4 Documentation resources

LocationDescriptionDocument

IT Management Suite (ITMS) 8.5 Documentation■ Information about new
features and
important issues.

■ Information about how
to use this product,
including detailed
technical information
and instructions for
performing common
tasks.

■ Release Notes
■ User Guides

The Documentation Library, which is available in the
Symantec Management Console on the Help menu.

Context-sensitive help is available for most screens in the
Symantec Management Console.

You can open context-sensitive help in the following ways:

■ Click the page and then press the F1 key.
■ Use the Context command, which is available in the

Symantec Management Console on the Help menu.

Information about how to
use this product,
including detailed
technical information and
instructions for
performing common
tasks.

Help is available at the
solution level and at the
suite level.

This information is
available in HTML help
format.

Help

In addition to the product documentation, you can use the following resources to learn about
Symantec products.

Table 1-5 Symantec product information resources

LocationDescriptionResource

Knowledge BaseArticles, incidents, and
issues about Symantec
products.

SymWISE Support
Knowledgebase

Unified Help SystemAll available IT
Management Suite and
solution guides are
accessible from this
Symantec Unified Help
System that is launched
on cloud.

Cloud Unified Help System
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Table 1-5 Symantec product information resources (continued)

LocationDescriptionResource

The links to various groups on Connect are as follows:

■ Deployment and Imaging
■ Discovery and Inventory
■ ITMS Administrator
■ Mac Management
■ Monitor Solution and Server Health
■ Patch Management
■ Reporting
■ ServiceDesk and Workflow
■ Software Management
■ Server Management
■ Workspace Virtualization and Streaming

An online resource that
contains forums, articles,
blogs, downloads,
events, videos, groups,
and ideas for users of
Symantec products.

Symantec Connect
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Preparing managed
computers for inventory

This chapter includes the following topics:

■ Preparing managed computers for inventory and metering

■ Uninstalling the Inventory and Application Metering plug-ins

Preparing managed computers for inventory and
metering

Inventory and application metering policies and tasks require that the target computers have
Symantec Management Agent installed on them.

See “About software usage tracking, application metering, and application denial” on page 103.

Table 2-1 Process for preparing managed computers for inventory and metering

DescriptionActionStep

You can discover the computers that are not yet managed by
Symantec Management Agent. When computers are discovered,
resource objects are created for them in the Configuration
Management Database (CMDB). You may have discovered
computers when you installed the Symantec Management Platform
or when you added new computers to the network.

For more information, see the topics about the resource discovery
in the IT Management Suite Administration Guide.

Discover the computers that you
want to manage.

Step 1
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Table 2-1 Process for preparing managed computers for inventory and metering
(continued)

DescriptionActionStep

You may have performed this task when you installed the
Symantec Management Platform or when you added new
computers to the network.

You can also install Symantec Management Agent manually.

For more information, see the topic about methods for installing
Symantec Management Agent for Windows, UNIX, Linux, and
Mac computers in the IT Management Suite Installation and
Upgrade Guide.

Install Symantec Management
Agent on the computers.

Step 2

To gather inventory or perform metering on managed computers,
you must install or upgrade the following plug-ins:

■ Inventory Plug-in
You can install this plug-in on Windows, UNIX, Linux, and Mac
computers.

■ Application Metering Plug-in
You can install this plug-in on managed Windows and Mac
client computers.

■ Inventory Pack for Servers Plug-in
If you have Inventory Pack for Servers, you can install this
plug-in on Windows, UNIX, and Linux computers.

See “Installing the Inventory and Application Metering plug-ins”
on page 36.

See “Upgrading the Inventory and Application Metering plug-ins”
on page 38.

Install or upgrade plug-ins on the
managed computers.

Step 3

Installing the Inventory and Application Metering plug-ins
To gather inventory data on managed computers, you must install Inventory Plug-in on them.

To meter applications on managed computers, you must install Application Metering Plug-in.
These plug-ins work with Symantec Management Agent to perform tasks on the managed
computers and communicate with Notification Server.

If you have Inventory Pack for Servers, you can also use the Inventory Pack for Servers Plug-in.
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Note: You can track usage of managed software products, meter, and deny Win64 and Win32
applications on Windows XP and above managed client computers.

You can track usage of managed software products on Mac client computers.

Software-based usage tracking and application metering are not supported on Windows and
Mac servers.

To install a plug-in, you configure the policy that installs the plug-in on managed computers.
You choose the group of computers on which the policy runs, and when it runs. If you choose
a group that contains a computer that already has the plug-in installed, the task is ignored on
that computer. When you turn on the policy, the plug-in is automatically installed on any new
computer that is a member of the target group.

By default, no plug-in installation policies are turned on. If you install Inventory Solution for the
first time, you must manually turn on the policies to install the Inventory and Application Metering
plug-ins.

You can install Inventory plug-in and Application Metering plug-in separately. However, if only
Application Metering plug-in is installed on the client computer, but the Inventory plug-in is not,
there are the following limitations:

■ You cannot gather information about installed software and files using Inventory policies
and tasks.

■ You cannot track software products if information about installed software is not gathered
on these computers.

■ The Underutilized Software report only shows the information about client computers on
which metered software has been recognized as installed.

Before you perform this task, you must install Symantec Management Agent on target
computers.

This task is a step in the process for preparing managed computers for inventory and metering.

See “Preparing managed computers for inventory and metering” on page 35.

To install the Inventory or Application Metering plug-ins

1 In the Symantec Management Console, on the Actions menu, click Agents/Plug-ins
> Roll out Agents/Plug-ins.

2 In the left pane, under Agents/Plug-ins, expand Discovery and Inventory >
Windows/UNIX/Linux/Mac, and then click the policy for the plug-in that you want to install.

3 In the right pane, on the toolbar, click Apply to to choose the computers on which you
want to install the plug-in.

For more information, see the topics about specifying the targets of a policy and specifying
filtering rules in the IT Management Suite Administration Guide.
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4 Under Schedule, on the toolbar, click Add schedule, and then schedule the policy to run
on managed computers.

5 On the plug-in install page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.

The next step is to gather inventory on your client computers.

See “Gathering inventory with predefined inventory policies” on page 41.

Upgrading the Inventory and Application Metering plug-ins
If you upgrade from a previous version of Inventory Solution, and you previously installed the
Inventory or Application Metering plug-ins, you must upgrade the plug-ins on client computers.

To upgrade a plug-in, you turn on an upgrade policy that is located with the plug-in installation
policy.

This task is a step in the process for preparing managed computers for inventory and metering.

See “Preparing managed computers for inventory and metering” on page 35.

To upgrade the Inventory or Application Metering plug-ins

1 In the Symantec Management Console, on the Actions menu, click Agents/Plug-ins
> Rollout Agents/Plug-ins.

2 In the left pane, expand Discovery and Inventory > Windows/UNIX/Linux/Mac, and
then click the policy for the plug-in that you want to upgrade.

The upgrade policy for x64 plug-in is received by 64-bit client computers. The x86 plug-in
policy is received by 32-bit computers. You cannot install a 32-bit plug-in on a 64-bit client
computer.

Note: The cloned policies that you have created with Inventory Solution 7.5 SP1 and
earlier still attempt to install or upgrade 32-bit plug-ins on 64-bit client computers. These
policies fail due to the change introduced in Inventory Solution 7.6.

3 On the plug-in upgrade page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

4 Click Apply to to select the computers on which you want to upgrade the plug-in.

For more information, see the topics about specifying the targets of a policy and specifying
filtering rules in the IT Management Suite Administration Guide.
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5 Schedule the policy to run on managed computers.

For more information, see the topic about adding a schedule to a policy, task, or job in
the IT Management Suite Administration Guide.

6 Click Save changes.

Uninstalling the Inventory and Application Metering
plug-ins

You can uninstall Inventory Plug-in or Application Metering Plug-in separately. Uninstalling
one of these Plug-ins does not affect the other. However, if you uninstall Inventory Plug-in,
the Inventory Pack for Servers Plug-in is also removed from the client computer.

Note: Before you uninstall the Inventory or Application Metering Plug-in, make sure that you
turn off the install policy of the corresponding plug-in.

See “Installing the Inventory and Application Metering plug-ins” on page 36.

To uninstall the Inventory or Application Metering plug-ins

1 In the Symantec Management Console, on the Actions menu, click Agents/Plug-ins
> Rollout Agents/Plug-ins.

2 In the left pane, expand Discovery and Inventory > Windows/UNIX/Linux/Mac, and
then click the policy for the plug-in that you want to uninstall.

3 On the plug-in uninstall page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

4 Click Apply to to select the computers from which you want to uninstall the plug-in.

For more information, see the topics about specifying the targets of a policy and specifying
filtering rules in the IT Management Suite Administration Guide.

5 Schedule the policy to run on managed computers.

For more information, see the topic about adding a schedule to a policy, task, or job in
the IT Management Suite Administration Guide.

6 Click Save changes.
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Gathering inventory on
managed computers

This chapter includes the following topics:

■ Gathering inventory on managed computers

■ About inventory policies and tasks

■ About predefined inventory policies

■ How inventory policies work

■ About running inventory policies and tasks on Windows computers using InvSoln.exe

Gathering inventory on managed computers
You can gather inventory data by running automated policies and tasks on managed computers.
To gather inventory, you need to install the Symantec Management Agent and Inventory Plug-in
on target computers. The inventory policies and tasks use Inventory Plug-in to perform the
inventory scan on the target computer. The inventory data is sent to the Configuration
Management Database (CMDB).

You can also use Inventory Pack for Servers, which is a separate product, to gather inventory
data from servers. If you have Inventory Pack for Servers installed, it uses the same type of
inventory policies.

See “About Inventory Pack for Servers ” on page 11.

Inventory policies let you gather inventory on a recurring schedule. Inventory Solution includes
the predefined inventory policies that you can use to gather inventory. You can also create
and configure your own inventory policies. You can use unique policies and schedules for
different kinds of inventory. For example, you can have one policy collect hardware inventory
daily, and another policy collect software inventory weekly.
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See “About inventory policies and tasks ” on page 46.

See “Methods for gathering inventory” on page 20.

Table 3-1 Process for gathering inventory on managed computers

DescriptionActionStep

Target computers must have Symantec Management Agent and
Inventory Plug-in installed.

See “Preparing managed computers for inventory and metering”
on page 35.

Prepare managed computers for
inventory.

Step 1

You need to turn on and configure a policy or a task to collect
inventory. You can use an existing policy or create and configure
your own policies or tasks.

See “Gathering inventory with predefined inventory policies”
on page 41.

See “Creating and configuring inventory policies and tasks”
on page 43.

Turn on an inventory policy or task,
or create a new inventory policy or
task.

Step 2

An inventory policy with the custom schedule does not run
automatically as soon as possible after the custom schedule is
created and on any new computer that joins the target collection.
You can configure the custom policy schedule to run the policy
immediately once and on a recurring schedule later.

See “Scheduling custom inventory policies to run immediately
once and on a recurring schedule later” on page 45.

(Optional) Configure custom
inventory policy schedules.

Step 3

You can view the gathered inventory data in reports or in the
Resource Manager.

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views”
on page 146.

View inventory results.Step 4

Video: For more information about gathering inventory, see Gathering Inventory with Inventory
Solution Video on Symantec Connect.

Gathering inventory with predefined inventory policies
You can gather inventory data from managed computers with predefined inventory policies.
You can also configure the predefined policies to meet your needs. If you want to configure a
predefined policy, Symantec recommends that you clone it, and then configure the copy.
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See “About predefined inventory policies” on page 47.

To use inventory policies or tasks, you must install Inventory Plug-in on target computers.

See “Preparing managed computers for inventory and metering” on page 35.

Note:You can manually run an original or modified predefined inventory policy on the managed
Windows computers. You can do it after the policy automatically runs on the computer at least
once.

See “About running inventory policies and tasks on Windows computers using InvSoln.exe”
on page 53.

This task is a step in the process for gathering inventory on managed computers.

See “Gathering inventory on managed computers” on page 40.

Before you perform these steps, ensure that you have prepared the managed computers for
inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To turn on predefined inventory policies

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, expand Discovery and Inventory > Inventory, and then click the
predefined inventory policy that you want to use.

3 On the inventory policy page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

4 Click Save changes.

To clone and configure predefined inventory policies

1 In the Symantec Management Console, browse to the predefined inventory policy that
you want to clone.

2 Right-click the policy, and then click Clone.

3 Give the cloned policy a unique name, and then click OK.

4 On the inventory policy page, configure the policy options according to your needs.

For more information about the options, click the page, and then press the F1 key.

5 On the inventory policy page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.
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The next step is to wait for the client computers to receive the new policy and report the
inventory results, and then view the data that is stored in the Configuration Management
Database (CMDB).

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views” on page 146.

Creating and configuring inventory policies and tasks
In the Task Management Portal, you can create new inventory policies or tasks. You can
configure policies and tasks to meet your further needs.

See “About inventory policies and tasks ” on page 46.

Before you can use inventory policies or tasks, you must install Inventory Plug-in on target
computers.

See “Preparing managed computers for inventory and metering” on page 35.

Note: You can manually run an inventory policy or task on the target Windows computer. You
can do it after the policy or task is automatically run on the computer at least once.

See “About running inventory policies and tasks on Windows computers using InvSoln.exe”
on page 53.

This task is a step in the process for gathering inventory on managed computers.

See “Gathering inventory on managed computers” on page 40.

To create and configure inventory policies

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Inventory.

2 In the Inventory Policy status Web Part, click New.

3 On the inventory policy page, configure the policy options according to your needs.

For more information about the options, click the page, and then press the F1 key.
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4 (Optional) Click Advanced to configure the data classes, the policy run options, or the
software inventory rules, and then click OK.

The scope of collected inventory information depends on the account permissions. For
example, if a particular user account does not have permission to access a file, the
information about this file is not collected. Also, the information about some inventory and
server inventory data classes (Task Scheduler Windows, File Share Windows, etc.) cannot
be collected if the user does not have administrator rights.

See “How software inventory rules work” on page 92.

For more information about the options in the Advanced Options dialog box, click the
dialog box, and then press the F1 key.

5 On the inventory policy page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.

To create and configure inventory tasks

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, navigate to the folder where you want to create an inventory task, right-click
the folder, and then click New > Task.

For example, to create an inventory task in the Inventory folder, expand Jobs and Tasks
> System Jobs and Tasks > Discovery and Inventory, right-click Inventory, and then
click New > Task.

3 In the Create New Task dialog box, in the left pane, under Discovery and Inventory,
click Gather Inventory.

4 In the right pane, give the task a descriptive name and select the types of inventory to
gather.

5 (Optional) Click Advanced to configure the data classes, the task run options, or the
software inventory rules, and then click OK.

See “How software inventory rules work” on page 92.

For more information about the options in the Advanced Options dialog box, click the
dialog box, and then press the F1 key.

6 Click OK to save the task.

7 On the task page, schedule the task to run on managed computers.

For more information, see the topic about adding a schedule to a policy, task, or job in
the IT Management Suite Administration Guide.

8 Click Save changes.

44Gathering inventory on managed computers
Gathering inventory on managed computers



The next step is to wait for the client computers to receive the new policy or task and report
the results, and then view the data that is stored in the Configuration Management Database
(CMDB).

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views” on page 146.

Scheduling custom inventory policies to run immediately once and
on a recurring schedule later

You can create a custom inventory policy with the custom schedule set according to your
needs. The custom inventory policy does not run automatically as soon as possible (ASAP)
after the custom schedule is created. The policy does not run automatically ASAP on any new
computer that joins the target collection.

However, you can manually specify the two custom schedules that behave as follows:

■ The first schedule runs the policy once at the nearest time after the schedule is created on
the current set of managed computers and on any new computer that joins the target
collection later

■ The second schedule reruns the policy later at the predefined time.

See “How inventory policies work” on page 51.

Before you perform this step, ensure that you have prepared the managed computers for
inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To schedule custom inventory policies to run immediately once and on a recurring schedule
later

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, click Discovery and Inventory > Inventory, and then, in the right pane,
select the inventory policy that you want to schedule.

3 Under Ensure my inventory is current, click Custom schedule.

4 In the Edit Policy Schedule dialog box, select Use agent time for the time zone.

5 To specify the schedule that runs the policy once immediately on the current set of
managed computers and on any new computer that joins the target group later, perform
the following steps in order

■ Click Add schedule > Scheduled time, and then specify the schedule that expires
in the next few minutes.
For example, if the current time is 7:50 A.M., set the schedule to 8:00 A.M.
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■ Click No repeat, in the Repeat schedule dialog box, click No repeat, and then click
OK.

6 To specify the schedule that reruns the policy later at the predefined time, perform the
following steps in order:

■ Click Add schedule > Scheduled time, and then specify the schedule

■ ClickNo repeat, in theRepeat schedule dialog box, specify the appropriate frequency,
and then click OK.

7 In the Edit Policy Schedule dialog box, click OK.

8 Under Applies To/Compliance, define the set of managed computers to which you want
to apply the policy.

9 On the inventory policy page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

10 Click Save changes.

The next step is to wait for the client computers to receive the new policy and report the results,
and then view the data that is stored in the Configuration Management Database (CMDB).

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views” on page 146.

About inventory policies and tasks
You can configure inventory policies and tasks that you want to run on managed computers.

Symantec recommends that you use policies, not tasks, for recurring inventory activities.

When you schedule an inventory policy, it runs on the schedule irrespective of whether any
maintenance window is open. When you schedule an inventory task on a set of computers
and do not select the Override Maintenance Window option, and the same set of computers
has a maintenance window enabled, the task waits for the maintenance window to open.

When you turn on an inventory policy, it automatically runs on any new computer that is a
member of the target group.

See “How inventory policies work” on page 51.

To use inventory policies or tasks, you must install the Inventory Plug-in on target computers.

See “Preparing managed computers for inventory and metering” on page 35.

You can use inventory policies and tasks in the following ways:
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A number of predefined policies are provided to help simplify
inventory gathering. You can use predefined policies as they
are or modify them to fit your needs. If you want to modify a
predefined policy, Symantec recommends that you clone the
original policy and then modify the copy.

See “Gathering inventory with predefined inventory policies”
on page 41.

Turn on predefined policies or clone and
configure existing policies.

You can create your own policies or tasks and configure them
to meet your needs.

You can also create and use inventory tasks. However, in most
cases, you want to limit them to the automated tasks that are
used in a workflow.

Symantec recommends that you use policies, not tasks, for the
recurring processes.

See “Creating and configuring inventory policies and tasks”
on page 43.

Create and configure your own policies
or tasks.

About predefined inventory policies
You can use predefined inventory policies to quickly start gathering inventory data. You can
configure predefined policies to meet your needs. If you want to configure a predefined policy,
Symantec recommends that you clone it, and then configure the copy.

See “Gathering inventory with predefined inventory policies” on page 41.

See “How inventory policies work” on page 51.

To use inventory policies, you must install Inventory Plug-in on target computers.

In addition to gathering inventory data, all inventory policies and tasks send data recency
information to Notification Server to ensure that the inventory data is current. Data recency
information helps Inventory Solution automatically detect the computers with data discrepancies
and maintain the inventory data consistency without overloading your environment.

See “About inventory performance tuning” on page 28.
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Table 3-2 Predefined inventory policies

NotesDefault
target

Default
schedule

Turned
on by
default?

Policy

This policy collects a full inventory. By default, it
collects hardware and operating system, software,
and file properties inventory data.

Symantec recommends that you collect full inventory
weekly, but you can configure the policy settings
according to your needs.

You must install Inventory Plug-in on target computers
before you can use this policy.

See “Preparing managed computers for inventory and
metering” on page 35.

All computers
with Inventory
Plug-in
installed

Weekly, every
Monday at
18:00 (6:00
P.M.)

YesCollect Full
Inventory

This policy reports only the data that has changed
since the last full inventory scan.

All computers
with Inventory
Plug-in
installed

Monthly, every
first Monday at
18:00 (6:00
P.M.)

NoCollect Delta
Hardware
Inventory

This policy reports only the data that has changed
since the last full inventory scan.

All computers
with Inventory
Plug-in
installed

Weekly, every
Monday at
18:00 (6:00
P.M.)

NoCollect Delta
Software Inventory
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Table 3-2 Predefined inventory policies (continued)

NotesDefault
target

Default
schedule

Turned
on by
default?

Policy

All computers
with Inventory
Plug-in
installed

Frequently
during a day

NoCollect
Time-Critical
Inventory
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Table 3-2 Predefined inventory policies (continued)

NotesDefault
target

Default
schedule

Turned
on by
default?

Policy

This policy collects the most important hardware and
software data classes on client computers frequently
during a day with repeat interval in hours. The policy
excludes the data classes that constantly change,
such as TCP and UDP ports.

The Real-Time Inventory feature of the policy lets
you gather software inventory on Windows client
computers in real time to validate the current software
state.

TheReal-Time Inventory feature does the following:

■ Monitors the software state on target Windows
client computers.

■ Invokes the software inventory scan within 10
minutes as soon as software is installed or
removed.

■ If the software state changes, sends delta
inventory and data recency information to
Notification Server.

■ If no changes are found, sends data recency
information to Notification Server.

As all inventory policies, the Collect Time-Critical
Inventory policy is configured to run as soon as
possible (ASAP) for the first time, apart from the
configured schedule. Additionally, the turned on
Collect Time-Critical Inventory policy runs ASAP if
the current policy differs from the previously processed
policy, and the interval between the policies is more
than 30 minutes.

If client computer receives different Collect
Time-Critical Inventory policies, the Inventory Plug-in
uses the settings of the first processed policy, and
ignores other policies.

If you need to gather the inventory on computers in
real time and perform immediate hardware and
software state analysis, you can also use Time Critical
Management feature.

For more information, see the topic about Time Critical
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Table 3-2 Predefined inventory policies (continued)

NotesDefault
target

Default
schedule

Turned
on by
default?

Policy

Management.

This policy only exists if the Inventory Pack for Servers
product is installed.

See “About Inventory Pack for Servers ” on page 11.

Even though this policy is turned on by default, you
must install Inventory Pack for Servers Plug-in on
target computers before inventory data is gathered.

See “Preparing managed computers for inventory and
metering” on page 35.

All computers
with Inventory
Pack for
Servers
Plug-in
installed

Weekly, every
Monday at
18:00 (6:00
P.M.)

YesCollect Full Server
Inventory
(Inventory Pack for
Servers required)

By default, this policy collects only the server
applications inventory data that has changed since
the last full server inventory.

All computers
with Inventory
Pack for
Servers
Plug-in
installed

Weekly, every
Monday at
18:00 (6:00
P.M.)

NoCollect Delta
Server Inventory
(Inventory Pack for
Servers required)

How inventory policies work
The predefined inventory policies are generally scheduled to run at 6:00 P.M. on Mondays.
Inventory policies are configured to run as soon as possible (ASAP) for the first time, apart
from the configured schedule.

The ASAP behavior is implemented in the following way:

■ The turned on predefined inventory policies run as follows:

■ Run ASAP after the first-time installation.

■ Run ASAP on any new computer that joins the target collection.

■ Run on the defined schedule.

■ The custom inventory policies that are turned on and scheduled to run daily, weekly, or
monthly run as follows:

■ Run ASAP after the schedule is created.

■ Run ASAP on any new computer that joins the target collection.
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■ Run on the defined schedule: Daily at 6:00 P.M., weekly on every Monday at 6:00 P.M.,
or monthly on every first Monday at 6:00 P.M.

■ The turned on custom inventory policies with the custom schedule set according to your
needs run as follows:

■ Do not run automatically ASAP after the schedule is created.

■ Do not run automatically ASAP on any new computer that joins the target collection.

■ Run on the recurring schedule that you define.
See “Scheduling custom inventory policies to run immediately once and on a recurring
schedule later” on page 45.

Inventory policies are not pushed from Notification Server, but pulled by Symantec Management
Agent. Thus, the run ASAP behavior depends on the following settings:

■ Update configuration interval.
This time is the default time when Symantec Management Agent checks with Notification
Server, if Notification Server has any new policies for it to run.
The default interval is one hour.

■ Symantec Management Agent basic inventory interval.
Notification Server allows Symantec Management Agent to pull inventory policies only if
Notification Server knows that the target computer has Inventory Plug-in installed.
The default interval is one day.

If the target computer does not have the Inventory Plug-in installed, and an administrator
installs Inventory Plug-in on that computer, the computer does not receive the inventory policy
ASAP until the computer updates its basic inventory information on Notification Server.

If your target computer has received an inventory policy but is turned off during the scheduled
policy execution time, then the policy works in the following way

■ For the first time after the policy rollout, the policy gathers inventory and sends the data to
Notification Server as soon as the computer gets turned on and Symantec Management
Agent gets updated.

■ Next time, the policy gathers and sends inventory only at the scheduled time.

This behavior applies to all inventory policies.

For example, the Collect full inventory policy is scheduled to run every Monday at 18:00
(6:00 P.M.). If your target computer is turned off at the scheduled time, then the policy works
as follows:

■ For the first time after the policy rollout, the policy runs on the computer, and inventory gets
posted to Notification Server as soon as the computer gets started on Tuesday and
Symantec Management Agent gets updated.
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■ All the following times, the policy waits until the computer is available on Monday at the
scheduled time, and then runs and gathers inventory.

See “About inventory policies and tasks ” on page 46.

About running inventory policies and tasks on
Windows computers using InvSoln.exe

Inventory Solution provides the utility InvSoln.exe that lets you run inventory policies and
tasks on managed Windows computers. You may need to initiate inventory scans on managed
Windows computers in the following cases:

■ You want to re-run inventory policies and tasks according to your needs. You want to initiate
inventory scans and view the progress window during the inventory scans.

■ You need to troubleshoot the problems that may arise when you run inventory policies or
tasks from the Notification Server computer.
For example, Symantec support can quickly gather the inventory on Windows computers
to diagnose any inventory data class issue.

Note that to gather inventory correctly the user running InvSoln.exe needs to have local
administrator rights.

When you install Inventory Solution, the Inventory Plug-in saves the InvSoln.exe utility and
the default task configuration files for the predefined inventory policies to the following locations
on managed Windows computers:

■ InvSoln.exe is located at %ProgramFiles%\Altiris\Altiris Agent\Agents\Inventory

Agent

■ The default task configuration files are located at %ProgramFiles%\Altiris\Altiris
Agent\Agents\Inventory Agent\InvTaskConfig

After a predefined inventory policy runs on a Windows client computer, the corresponding task
configuration file is replaced in its location by the reference for policy configuration with the
same policy name. The actual policy configuration is associated with this reference.

You can use InvSoln.exe to collect inventory on client computers with predefined or custom
inventory policies and tasks.

To run the predefined inventory policies on Windows client computers with the InvSoln.exe

utility, run the following commands at the command prompt:
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Table 3-3 Default commands to run the predefined inventory policies

DescriptionCommand

The command to run the predefined policy Collect Delta Hardware
Inventory.

InvSoln.exe /dhi

The command to run the predefined policy Collect Delta Software
Inventory.

InvSoln.exe /dswi

The command to run the predefined policy Collect Full Inventory.InvSoln.exe /fi

The command to run the predefined policy Collect Delta Server
Inventory.

Note that the command runs inventory collection only when the Inventory
Pack for Servers Plug-in is installed on client computers.

InvSoln.exe /dsi

The command to run the predefined policyCollect Full Server Inventory.

Note that the command runs inventory collection only when the Inventory
Pack for Servers Plug-in is installed on client computers.

InvSoln.exe /fsi

See “About predefined inventory policies” on page 47.

You can modify the predefined policy on the Notification Server computer. After Inventory
Plug-in or Inventory Pack for Servers Plug-in receives and runs the modified policy, the default
task configuration of the predefined policy gets overwritten on managed Windows computers.
You can then use the default commands to run the modified predefined policies.

See “Gathering inventory with predefined inventory policies” on page 41.

When the predefined policy runs on managed Windows computers, the progress window for
gathering inventory does not appear by default. To view the progress window during the
inventory scan, you can run the /p true command-line switch at the command prompt. To
hide the progress window during the inventory scan, you can run the /p false command line
switch at the command prompt. By specifying the /p true or /p false command line options,
you update the configuration of the policy or task, and save it for future use.

For example, to run the Collect Delta Hardware Inventory policy and view the progress
window, you run the following command:

InvSoln.exe /dhi /p true

To view the details of other available command-line options, you can run one of the following
commands at the command-prompt:

InvSoln.exe /?

InvSoln.exe /Help
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You can create a new inventory policy or task on the Notification Server computer. When you
configure the policy or task, you specify the managed Windows computers to which the policy
or task applies. After the Plug-in receives and runs the new policy or task, the reference for
the configuration of the policy or task is saved to the following location on managed Windows
computers:

%ProgramFiles%\Altiris\Altiris Agent\Agents\Inventory Agent\InvTaskConfig

For example, if you create a policy Select HW Data classes, the Plug-in saves the reference
for policy configuration Select HW Data classes.xml. If you create aGather Inventory task,
the Plug-in saves the reference for task configuration Gather Inventory.xml.

You can use the InvSoln.exe utility and the saved reference to run the newly created inventory
policy or task on managed Windows computers, and then view the progress window. To do
this, you run the following command at the command-prompt:

InvSoln.exe /i "%ProgramFiles%\Altiris\Altiris Agent\Agents\Inventory

Agent\InvTaskConfig\%reference-file-name%" /p true

For example, to run the Select HW Data classes policy and view the progress window, you
run the following command:

InvSoln.exe /i "%ProgramFiles%\Altiris\Altiris Agent\Agents\Inventory

Agent\InvTaskConfig\Select HW Data classes.xml" /p true

To run the Gather Inventory task and hide the progress window, you run the following
command:

InvSoln.exe /i "%ProgramFiles%\Altiris\Altiris Agent\Agents\Inventory

Agent\InvTaskConfig\Gather Inventory.xml" /p false

See “Creating and configuring inventory policies and tasks” on page 43.
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Gathering inventory using
stand-alone packages

This chapter includes the following topics:

■ About gathering inventory using stand-alone packages

■ Gathering inventory using stand-alone packages

Aboutgathering inventoryusingstand-alonepackages
This type of inventory is for Windows computers only.

A stand-alone inventory package is an executable file that you create from the Symantec
Management Console. You run the package on target computers and gather the inventory
data on that computer. This method lets you gather inventory on the target computers that are
not managed through Symantec Management Agent.

Warning: Standalone inventory package does not support collecting inventory data that can
only be collected with provided database credentials. If you define database credentials in the
standalone package, they cannot be decrypted when the package is executed, and only limited
scope of data for the database is collected

If you use stand-alone packages, you must be able to report the inventory data back to the
Notification Server computer. You can use different options of reporting data depending on
the configuration of your network. You can create multiple packages with different options
according to your needs.
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Warning: After migration, the stand-alone packages that you created before the migration
continue using old files and settings. For example, if a standalone package was configured to
post NSE files directly to Notification Server, after migration, when the host name of Notification
Server changes, the package continues posting NSE files to old Notification Server, not to the
new one. For the standalone packages to function correctly, you need to recreate them after
migration.

See “Gathering inventory using stand-alone packages” on page 57.

To run a stand-alone package and gather the inventory correctly, the logged on user must
have administrator rights.

Gathering inventory using stand-alone packages
This type of inventory is for Windows computers only.

Stand-alone packages let you gather inventory on the computers that are not managed through
Symantec Management Agent.

See “About gathering inventory using stand-alone packages” on page 56.

Table 4-1 Process for gathering inventory using stand-alone packages

DescriptionActionStep

You create stand-alone inventory packages in the
Symantec Management Console.

See “Creating, editing, or cloning stand-alone
inventory packages” on page 58.

Create a stand-alone inventory
package.

Step 1

You run the stand-alone packages that gather the
inventory data on the target computers.

To run a stand-alone package, you need to have
administrator rights.

See “Running stand-alone inventory packages on
target computers” on page 62.

Run the stand-alone inventory
package on the target computers.

Step 2

If the target computers cannot communicate directly
with the Notification Server computer, you must
manually report the inventory data.

See “Manually reporting standalone inventory data”
on page 64.

If necessary, manually copy
inventory data to the Notification
Server computer.

Step 3
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Table 4-1 Process for gathering inventory using stand-alone packages (continued)

DescriptionActionStep

You can view the gathered inventory data in reports
or in the Resource Manager.

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource
Manager” on page 145.

See “Viewing inventory data in Computers and
Software views” on page 146.

View inventory results.Step 4

Creating, editing, or cloning stand-alone inventory packages
This type of inventory is for Windows computers only.

You can create, edit, or clone stand-alone inventory packages. When you configure a package,
you specify how the data is reported to the Notification Server computer. The inventory data
is stored in files with an NSE extension.

By default, your stand-alone inventory packages are located on your Notification Server
computer in the following location:

%InstallDir%\Altiris\Notification

Server\NSCap\bin\Win32\X86\Inventory\StandalonePackages

This task is a step in the process for gathering inventory using stand-alone packages.

See “Gathering inventory using stand-alone packages” on page 57.

To create, edit, or clone a stand-alone inventory package

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, expandDiscovery and Inventory > Inventory Solution,
and then click Stand-alone Inventory Packages.

3 In the right pane, do one of the following:

■ To create a new package, click New package.

■ To edit a package, select an existing package and click the Edit symbol.

■ To create an identical copy of a package, select a package, and then click Clone
package.
On the Cloning the package page, name the package, and then click OK.

4 Name and describe the package.
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5 Configure the package options.

See “Stand-alone inventory package options” on page 59.

6 Click OK.

7 You can view the properties of the package from the Stand-alone Inventory Packages
page.

The properties include the path of the package file as well as the configuration settings
of the package.

The next step is to run the stand-alone package on the target computer.

See “Running stand-alone inventory packages on target computers” on page 62.

Stand-alone inventory package options
This type of inventory is for Windows computers only.

When you create or edit a stand-alone inventory package, you can configure its settings. You
define the type of inventory gathered, where to store the data, etc. You can view the properties
of a package from the main Stand-alone Inventory Packages page.

You specify where to store the inventory data on the basis of the access that the target
computers have to the Notification Server computer.

See “Gathering inventory using stand-alone packages” on page 57.

See “Creating, editing, or cloning stand-alone inventory packages” on page 58.

See “Running stand-alone inventory packages on target computers” on page 62.

Note:When the package is run, you can override some of these settings with a command-line
switch.

See “Stand-alone inventory package command-line switches” on page 63.

Table 4-2 Stand-alone inventory package options

DescriptionSetting

You can specify the type of inventory data to gather.

To select a detailed set of data, click Advanced.

Select the types of
inventory to gather

The option Show progress opens a dialog box on the computer that is running the
package. The dialog box displays the data classes that are gathered, and where the
data is posted after the inventory is completed.

When running on the target
computer
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Table 4-2 Stand-alone inventory package options (continued)

DescriptionSetting

The option Keep the inventory cached for future comparisons lets you keep the
inventory data cached so that you can compare the inventory data in the future.
Inventory data comparisons are performed using command-line switches.

See “Running stand-alone inventory packages on target computers” on page 62.

After running on the target
computer
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Table 4-2 Stand-alone inventory package options (continued)

DescriptionSetting

This option lets you specify where the inventory data is stored after it is gathered.

You can choose from the following options:

■ Notification Server
You can use this option if the target computers can communicate with the Notification
Server computer using HTTP (port 80 open) or HTTPS (port 443 open). When the
package is run, the inventory data is automatically sent to the Notification Server
computer.
The URL that is used is displayed on the page.

■ Folder
You can store the data on the local computer, on a share, or on the Notification
Server computer. When the package is run, the inventory data is automatically
saved on that share. Inventory data files are stored with an NSE extension.
If target computers can access a shared folder on the Notification Server computer,
you can store it directly on a share on the server.
The Notification Server computer share to use with this option is:
\\notification_server_name\NSCap\EvtInbox
If the target computer cannot access the Notification Server computer, you can
store the inventory data on the local computer. You can also store it on another
computer that is not the Notification Server computer. You must then manually copy
the files to the Notification Server computer.
You may have to use this option for the following types of computers:
■ Computers that are not regularly attached to the network.
■ Computers that are outside the intranet that the Notification Server computer is

on.
You can specify a share or a path on the local computer. If you specify a local path,
a folder is created on each target computer.
For example, C:\Inventory_Data
Inventory data files are stored with an NSE extension.
You can also use environment variables when specifying the path to the folder.
For example, \\IntermediateShare\%computername%

If standalone inventory fails to post the NSEs to the specified target (an HTTP or HTTPS
location or a folder), it deletes the NSE, NSI, and BAK files from the following folders
%programfiles%\Altiris\NSI and
%programfiles%\Altiris\Inventory\Outbox.

When the standalone inventory runs next time, it recreates the inventory. The NSI and
Outbox folders are removed if they are empty. This procedure ensures that the
standalone inventory reports correct inventory to the Notification Server computer even
if the users are running stand-alone inventory packages with the
/SendChangedInventory command-line switch.

Send inventory data to
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Table 4-2 Stand-alone inventory package options (continued)

DescriptionSetting

You can configure advanced settings for running a stand-alone inventory package.Advanced

Running stand-alone inventory packages on target computers
This type of inventory is for Windows computers only.

After you create stand-alone inventory packages on Notification Server, you run the packages
on target computers to gather inventory data. Stand-alone inventory packages are EXE files.

See “Creating, editing, or cloning stand-alone inventory packages” on page 58.

To run a stand-alone package and gather the inventory correctly, the logged on user must be
a local administrator.

This task is a step in the process for gathering inventory using stand-alone packages.

See “Gathering inventory using stand-alone packages” on page 57.

To run stand-alone inventory packages on target computers

1 Make the stand-alone inventory package available to the target computers.

See “About methods for making stand-alone inventory packages available to target
computers” on page 63.

2 (Optional) Use command-line switches to modify the default behavior of the package.

See “Stand-alone inventory package command-line switches” on page 63.

3 Run the stand-alone inventory package.

4 (Optional) If you distribute the stand-alone inventory packages manually, you must also
manually copy the inventory data files to the Notification Server computer after you run
the package.

See “Manually reporting standalone inventory data” on page 64.

The next step is to view the inventory results.

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views” on page 146.

If necessary, you can also manually copy the inventory data to Notification Server computer.

See “Manually reporting standalone inventory data” on page 64.
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About methods for making stand-alone inventory packages available
to target computers

This type of inventory is for Windows computers only.

Before you can run stand-alone inventory package, you must make it available to the target
computers.

See “Running stand-alone inventory packages on target computers” on page 62.

You can use different methods to make the packages available to target computers. The
method that you use affects how the inventory data is reported back to Notification Server.

Table 4-3 Methods for making the stand-alone inventory packages available to target
computers

DescriptionMethod

If target computers can communicate with the Notification Server
computer, you can make the stand-alone inventory packages available
on the Notification Server computer. Target computers can access the
packages in following ways:

■ From a Notification Server URL (port 80 open for HTTP and port 443
open for HTTPS)

■ From a Notification Server share

See “Stand-alone inventory package options” on page 59.

When you create a package, you can view the paths for the package on
the Stand-alone Inventory Packages page.

Packages are made available
on the Notification Server
computer.

If the target computer cannot access the Notification Server computer
using a URL or share, you can manually distribute the package. For
example, you can email the package or place it on a different server's
share or URL.

If you use this method, you must manually copy the inventory data files
to the Notification Server computer after you run the package.

See “Manually reporting standalone inventory data” on page 64.

Packages are distributed
manually.

Stand-alone inventory package command-line switches
When you run a stand-alone inventory package, the package uses the options that you specified
when you created the package. When you run a package, you can use command-line switches
to modify default behavior.

See “Stand-alone inventory package options” on page 59.

See “Running stand-alone inventory packages on target computers” on page 62.

63Gathering inventory using stand-alone packages
Gathering inventory using stand-alone packages



These switches are not case-sensitive.

Table 4-4 Stand-alone inventory package command-line switches

DescriptionCommand-line switch

By default, all the errors are logged. If you specify /EnableVerboseLog at the
command line, it enables verbose logging. If verbose logging is enabled, the trace
messages are also logged.

The log is stored on the local computers at the following locations:

■ On managed computers, in InstallDir\Altiris\Altiris Agent\Logs
folder, as Agent*.log

■ On unmanaged computers, in %ProgramFiles%\Altiris\Altiris
Agent\Logs folder, as a*.log.

/EnableVerboseLog

By default, a stand-alone inventory package reports all the gathered inventory data. If
you use this switch, the package reports only the inventory data that has changed since
the last scan.

To gather only changed data, the package compares the gathered inventory data to
the previously collected data, if the previous data was cached. To cache inventory
data, check Keep the inventory cached for future comparisons in the package
configuration page.

See “Creating, editing, or cloning stand-alone inventory packages” on page 58.

If no previous inventory data is present, all gathered inventory is reported.

If you have multiple Notification Servers, do not use this option if you report data to a
server that does not have any previously gathered data stored on it.

/SendChangedInventory

Use this switch to override the value for the Send inventory data to option that is
specified in the stand-alone package.

The destination can be either an http(s) link to the Notification Server computer or a
folder path. For example, you can store the NSE on a USB drive.

You can use environment variables when specifying the destination.

For example, you can use the following command:

package_name.exe /SendInventoryTo
\\server_name\Inventory\%COMPUTERNAME%.

This command creates a separate folder for each computer at
\server_name\Inventory and stores the NSEs in that folder. The folder is the
same as the target computer’s name.

/SendInventoryTo
destination

Manually reporting standalone inventory data
This type of inventory is for Windows computers only.
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When the stand-alone inventory package runs, its settings or a command-line switch determine
where the inventory data is stored. If the stand-alone inventory package saves the inventory
data to a location other than the Notification Server computer, you must manually copy the
inventory data.

See “Running stand-alone inventory packages on target computers” on page 62.

The inventory data is stored in files with an NSE extension. The NSE files must be copied to
a Notification Server computer by a user who has rights to the server. Generally, any user on
a managed computer has sufficient rights.

This task is a step in the process for gathering inventory using stand-alone packages.

See “Gathering inventory using stand-alone packages” on page 57.

Manually reporting standalone inventory data

◆ Copy the inventory files to the following folder:

\\notification_server_name\NSCap\EvtInbox

When the files are copied, the inventory data is stored in the Configuration Management
Database (CMDB).
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Gathering agentless
inventory from network
devices

This chapter includes the following topics:

■ About Inventory for Network Devices

■ About gathering agentless inventory from network devices

■ About SNMP data mapping

■ Working with SNMP data mapping tables

■ Creating agentless inventory tasks for network devices using the inventory wizard

■ Manually creating and configuring agentless inventory tasks

■ Viewing agentless inventory data

About Inventory for Network Devices
Inventory for Network Devices gathers inventory data from the discovered devices in your
network. This inventory is gathered from the devices that are not managed through Symantec
Management Agent. Because a management agent is not required, this inventory is considered
an agentless inventory.

Agentless inventory gathers inventory from the devices that are already discovered and exist
as resources in the Configuration Management Database (CMDB).
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Agentless inventory tasks run on discovered devices and report the data to Notification Server.
The discovery data is stored in the CMDB. You can configure the automated tasks that are
scheduled to run at regular intervals to keep your inventory data current.

You can gather inventory on the following types of devices:

■ Cluster

■ Computer

■ Computer: virtual machine

■ Infrastructure device

■ IP phone

■ KVM device

■ Network-attached storage

■ Network backup device

■ Network printer

■ Out-of-band management device

■ Out-of-band management device: chassis management controller

■ Physical rack

■ Physical enclosure

■ Physical bay

See “About gathering agentless inventory from network devices” on page 68.

Inventory for Network Devices gathers inventory only on SNMP-enabled network devices. You
can determine the type of inventory that is gathered through SNMP data mapping tables. The
tables identify the data fields that you want to collect and apply the settings to selected device
types.

See “About SNMP data mapping” on page 70.

Before you gather inventory from network devices, you must collect the data about the
SNMP-enabled devices on your network. Use the Network Discovery task to discover your
network devices. Make sure that the connection profile of the Network Discovery task has
the SNMP turned on.

For more information, see topics about Network Discovery in the IT Management Suite
Administration Guide.

Inventory for Network Devices includes the following components:
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Table 5-1 Components of Inventory for Network Devices

DescriptionComponent

You create and schedule the tasks to collect
inventory from discovered network devices.

See “About gathering agentless inventory from
network devices” on page 68.

Inventory for Network Devices tasks (also known
as agentless inventory tasks)

You can use the wizard to create agentless
inventory tasks.

See “Creating agentless inventory tasks for network
devices using the inventory wizard” on page 73.

Agentless inventory wizard

This portal page provides links to the commonly
used tasks and a summary of inventory data.

Agentless Inventory Home page

These tables define the type of inventory data that
is gathered.

See “About SNMP data mapping” on page 70.

SNMP data mapping tables

About gathering agentless inventory from network
devices

Inventory for Network Devices lets you gather agentless inventory data from the discovered
SNMP network devices such as computers, network printers, network-attached storage devices,
and network backup devices. To gather inventory, agentless tasks run on discovered devices
and report the data to Notification Server. The data is stored in the Configuration Management
Database (CMDB). You can configure the automated tasks that are scheduled to run at regular
intervals to keep your inventory data current.

See “About Inventory for Network Devices” on page 66.

When you configure agentless inventory tasks, you can specify the following:

■ Which devices to inventory

■ When to run the task

You can create and configure agentless inventory tasks in the following ways:
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The wizard guides you through the creation and configuration of agentless
inventory tasks. You can later configure the advanced settings and
schedules of a task on the task page.

See “Creating agentless inventory tasks for network devices using the
inventory wizard” on page 73.

Create a task with Agentless
Inventory wizard.

You can manually create tasks from the Agentless Inventory Tasks
Web Part. This option lets you configure more advanced settings and
schedules.

See “Manually creating and configuring agentless inventory tasks”
on page 75.

Create a task manually

You can only gather inventory from the SNMP-enabled devices on your network that are
already discovered. Run the Network Discovery task to discover your network devices and
create resources for them in the CMDB. Make sure that the connection profile of the Network
Discovery task has the SNMP turned on.

For more information, see topics about Network Discovery in the IT Management Suite
Administration Guide.

Agentless inventory tasks use connection profiles to manage the protocols that are used to
communicate with network devices. Connection profiles are components of the Symantec
Management Platform. When a device is discovered, a resource for that device is created in
the CMDB. The resource keeps a record of the protocols that were used to communicate with
the device. Agentless inventory tasks automatically use the same protocols that were enabled
when the device was discovered.

For more information, see the topics about resource discovery and using connection profiles
in the IT Management Suite Administration Guide.

The process for gathering agentless inventory from network devices is as follows:

Table 5-2 Process for gathering agentless inventory from network devices

DescriptionActionStep

You can only gather inventory from the network
devices that are already discovered.

For more information, see topics about Network
Discovery in the IT Management Suite Administration
Guide.

Discover network devices.Step 1
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Table 5-2 Process for gathering agentless inventory from network devices (continued)

DescriptionActionStep

SNMP data mapping tables identify the data fields
that you want to gather inventory from and apply the
settings to the selected device types.

See “Working with SNMP data mapping tables”
on page 71.

Use SNMP data mapping tables to
define how to map SNMP devices
to the data that you want to gather.

Step 2

You create and schedule agentless inventory tasks
to collect inventory. You can create the tasks either
with inventory wizard or manually.

See “Creating agentless inventory tasks for network
devices using the inventory wizard” on page 73.

See “Manually creating and configuring agentless
inventory tasks” on page 75.

Create and run agentless inventory
tasks.

Step 3

You can view the gathered inventory data in the
Resource Manager or on the Agentless Inventory
page.

See “Viewing agentless inventory data” on page 76.

View agentless inventory data.Step 4

About SNMP data mapping
SNMP data mapping tables let you define how to map SNMP devices to the data that you
want to gather. Inventory for Network Devices provides predefined SNMP data mapping tables
for common SNMP devices. The predefined tables are read-only and cannot be edited.

You can also create your own custom SNMP data mapping tables.

See “Working with SNMP data mapping tables” on page 71.

When you create a new SNMP data mapping table, you specify Management Information Base
(MIB) data objects, also known as MIB files or MIBs. MIBs are the data objects that are defined
in the database. An SNMP manager uses them to control hardware and software resources.
MIBs let you expand the data fields that can be collected during inventory. Inventory for Network
Devices provides many MIBs of the leading hardware manufacturers. You can also import
additional MIBs using the MIB Import task. The MIB files that you import with the MIB Import
task can have the .MIB, .MY, or any other file extension for MIB files.

For more information, see the topic about importing MIB files using the MIB import task in the
IT Management Suite Administration Guide.
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When you map SNMP data mapping tables to a device, you choose a device from a list of
classified SNMP devices. This list includes the SNMP devices that are configured on the SNMP
Device Classifications page of Network Discovery.

Working with SNMP data mapping tables
SNMP data mapping tables let you define how to map SNMP devices to the data that you
want to gather. Inventory for Network Devices provides many predefined SNMP data mapping
tables for common SNMP devices. The predefined tables are read-only and cannot be edited.

See “About SNMP data mapping” on page 70.

If you manage network devices in a large infrastructure, you can export configured SNMP data
mapping tables and send them to other locations within your organization. This method is an
easy way to ensure that all Notification Servers that use Inventory for Network Devices gather
the same inventory.

See “To export an SNMP data mapping table” on page 73.

See “To import an SNMP data mapping table” on page 73.

You can also test table definitions to ensure that you have defined the field values for a table
definition correctly. When you test the table, you test it on a single device that you specify.

See “To create a new SNMP data mapping table” on page 72.

Before you perform these steps, make sure you have discovered the network devices.

For more information, see topics about Network Discovery in the IT Management Suite
Administration Guide.

To view an SNMP data mapping table

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 On the Agentless Inventory Home page, in the Agentless Inventory Quick Start Web
Part, click Data mapping tables.

3 On the SNMP Data Mapping Tables page, in the left pane, click the table that you want
to view.

4 In the right pane, on the Table details tab, view table details.

On the Device mappings tab, view the SNMP devices to which the table is mapped.
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To create a new SNMP data mapping table

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 On the Agentless Inventory Home page, in the Agentless Inventory Quick Start Web
Part, click Data mapping tables.

3 On the SNMP Data Mapping Tables page, on the toolbar, click New.

4 In the New Table dialog box, type a new table name, and then click OK.

5 In the right pane, under Table Columns, on the toolbar, click New.

6 In the Edit Row Values dialog box, do the following:

■ Type the name and length of the row.
The length of some types is predefined.

■ (Optional) Check Key to enable the row to be a primary key in the data table.

■ Click Select OID to select an Object ID.
The Object ID is mapped to the source of the protocol information. For example, it can
map to the Object ID for an SNMP query.
In the Object ID Selection Tool dialog box, click one of the following options, perform
the required actions, and then click Save changes:

In the MIB drop-down list, choose an Object ID from an available MIB
according to your needs.

Note that the selected Object ID data pre-populates the field for a custom
Object ID so that you can edit it later.

Select an Object
ID from an
available MIB

To define a custom Object ID, do one of the following:
■ Type a custom Object ID.
■ Edit the pre-populated data from the Object ID that you have selected

earlier.

Specify or edit a
custom Object ID

7 Click OK.

8 Click Save changes.

9 Click the Device Mappings tab, and check the devices that you want to apply this table
to.
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10 Click Test on device.

In the Test Table Mappings on Device dialog box, in the Host address box, type the
host address or host name of the device that you want to test, and then click Test.

The data appears if a valid response is received from the device.

Click Close.

11 Click Save changes.

To export an SNMP data mapping table

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 On the Agentless Inventory Home page, in the Agentless Inventory Quick Start Web
Part, click Data mapping tables.

3 On the SNMP Data Mapping Tables page, in the left pane, click the table that you want
to export, in the upper left corner, click the Tools icon, and then click Export.

4 In the dialog box that open, choose the directory where you want to export the file, and
then click Save.

By default, the file name is the same as the table name.

To import an SNMP data mapping table

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 On the Agentless Inventory Home page, in the Agentless Inventory Quick Start Web
Part, click Data mapping tables.

3 On the SNMP Data Mapping Tables page, in the left pane, click Import.

4 Browse to the file that you want to import, and then click OK.

The next step is to create an agentless inventory task for network devices.

See “Creating agentless inventory tasks for network devices using the inventory wizard”
on page 73.

See “Manually creating and configuring agentless inventory tasks” on page 75.

Creating agentless inventory tasks for network
devices using the inventory wizard

The wizard guides you through the process of creating agentless inventory tasks and configuring
basic settings. You can later configure the advanced settings and schedule the tasks on the
task page.

73Gathering agentless inventory from network devices
Creating agentless inventory tasks for network devices using the inventory wizard



This task is a step in the process for gathering agentless inventory from network devices.

See “About gathering agentless inventory from network devices” on page 68.

Before you perform this step, make sure that you have mapped the SNMP devices to the data
that you want to gather.

See “About SNMP data mapping” on page 70.

To create agentless inventory tasks for network devices using the inventory wizard

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 In the Agentless Inventory Quick Start Web Part, click Run inventory wizard.

3 In the Agentless inventory task creation wizard, on the Choose devices to inventory
page, do the following:

■ Select Choose devices, and then, in the drop-down list, click the group of target
devices that you want to gather inventory from.
For more information, see topics about using filters and organizational views in the IT
Management Suite Administration Guide.

■ Under Include Device Types, check the types of devices that you want to gather
inventory from.

■ (Optional) To gather inventory from an individual device, in the wizard, select Individual
device, and then, in the drop-down list, click the device that you want to gather inventory
from
This list includes all SNMP-enabled devices that have been previously discovered and
have resources in the Configuration Management Database (CMDB).

4 On the Inventory network task name page, type a name for the task, and then click
Next.

5 On the Schedule task page, configure the task schedule, and then click Finish.

6 (Optional) To view the created task, do one of the following:

■ In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory, and then view the task in theAgentless Inventory
Tasks Web Part.
Note that to view the newly created task, you may need to click the Refresh symbol.

■ In the Symantec Management Console, on the Manage menu, click Jobs and Tasks,
and then, in the left pane, under Jobs / Tasks, expand System Jobs and Tasks >
Discovery and Inventory.

The next step is to view the agentless inventory data.

See “Viewing agentless inventory data” on page 76.
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Manually creatingandconfiguringagentless inventory
tasks

You can manually create and configure agentless inventory tasks on theAgentless Inventory
Home page.

This task is a step in the process of gathering agentless inventory from network devices.

See “About gathering agentless inventory from network devices” on page 68.

Before you perform these steps, make sure that you have mapped the SNMP devices to the
data that you want to gather.

See “About SNMP data mapping” on page 70.

To manually create agentless inventory tasks

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 In the Agentless Inventory Tasks Web Part, on the Available Tasks tab, on the toolbar,
click New.

3 In the New Agentless Inventory Task dialog box, give the task a descriptive name, and
then do the following:

■ Select Group of Devices, and then, in the drop-down list, click the group of devices
that you want to gather inventory from.
For more information, see the topics about using filters and organizational views in
the IT Management Suite Administration Guide.

■ UnderGroup of Devices, check the types of devices that you want to gather inventory
from.

■ (Optional) To gather inventory from an individual device, select Individual device,
and then, in the drop-down list, click the device that you want to gather inventory from
This list includes all SNMP-enabled devices that have been previously discovered and
have resources in the Configuration Management Database (CMDB).

■ (Optional) Click Advanced, specify the maximum number of threads per inventory
task, and then click OK.
During the inventory process, a separate thread is used for each device. The maximum
number of threads is based on the amount of traffic that you want this task to generate
and on the capacity of your Notification Server computer.

4 Click OK.
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To configure or stop agentless inventory tasks

1 In the Symantec Management Console, on the Home menu, click Discovery and
Inventory > Agentless Inventory.

2 In the Agentless Inventory Tasks Web Part, on the Available Tasks tab, click the task
that you want to schedule, and then do one of the following:

■ To configure the task run schedule, on the toolbar, click Schedule.
In theNew Schedule dialog box, configure the task according to your needs, and then
click Schedule.

■ To configure the task settings, on the toolbar, click the Edit symbol.
In the New Agentless Inventory Task dialog box, configure the task according to
your needs, and then click OK.

■ To stop the task, click the Tasks Run tab, click the task that you want to stop, and
then, on the toolbar, click Stop.

The next step is to view the agentless inventory data.

See “Viewing agentless inventory data” on page 76.

Viewing agentless inventory data
The data collected by the inventory tasks is stored in the CMDB.

You can view the collected data and the additional details about the devices in the Resource
Manager or on the Agentless Inventory Home page.

For more information, see the topics about Resource Manager in the IT Management Suite
Administration Guide.

See “Manually creating and configuring agentless inventory tasks” on page 75.

This task is a step in the process for gathering agentless inventory from network devices.

See “About gathering agentless inventory from network devices” on page 68.

To view agentless inventory data in the Resource Manager

1 In the Symantec Management Console, on the Manage menu, click Resource.

2 In the Select Resource dialog box, click the resource that you want to view, and then
click OK.
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Gathering custom inventory

This chapter includes the following topics:

■ About gathering custom inventory

■ Gathering custom inventory

About gathering custom inventory
To extend the type of inventory data that you gather, custom inventory lets you create the new
data classes that are not included by default.

Custom inventory also lets you extend the use of predefined data classes by configuring them.
For example, the attributes of the Processor Extension data class are Device ID, L2 Cache
Size, and L2 Cache Speed. You add or remove the data class attributes.

See “Gathering custom inventory” on page 78.

See “Creating and configuring a data class” on page 79.

If you save an empty custom data class in the Configuration Management Database (CMDB),
you can modify it in the following ways:

■ You can add nullable, non-nullable, key, and non-key attributes to it.

■ You can delete its attributes.

■ You can change the properties of its attributes.

If the custom data class already contains data, you cannot modify it.

After you configure a data class, you create a task with scripting logic and schedule it to run
on the managed computers.

See “Creating a custom inventory script task” on page 81.
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Warning: Use caution if you gather inventory using the custom data class, and the same data
class is also part of the standard inventory. When a standard inventory follows a custom
inventory, the data that the standard inventory gathers overwrites the data that the custom
inventory gathers. To prevent the custom inventory data from being overwritten, you must
perform the custom inventory after the standard inventory.

Gathering custom inventory
Custom inventory lets you configure the set of inventory data that is gathered and reported to
the Configuration Management Database (CMDB).

See “About gathering custom inventory” on page 77.

Table 6-1 Process for gathering custom inventory

DescriptionActionStep

Target computers must be managed by Symantec
Management Agent.

See “Preparing managed computers for inventory
and metering” on page 35.

Prepare managed computers for
inventory.

Step 1

After you create a custom data class, you can add,
edit, and delete its attributes.

See “Creating and configuring a data class”
on page 79.

Create a custom data class.Step 2

You can create a new task, or clone an existing
sample task. You can use the script that is included
in the sample task or you can create your own logic.

Depending on the platform, you can write the logic
in JavaScript, shell script, or other scripting
languages.

See “Creating a custom inventory script task”
on page 81.

Create a task with scripting logic
and schedule it to run on the
managed computers.

Step 3

You can view the gathered custom inventory data
for a data class in the Resource Manager.

See “Viewing inventory data in the Resource
Manager” on page 145.

View custom inventory results.Step 4
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About custom inventory data classes
A data class is a table in the Configuration Management Database (CMDB). For example, the
Processor_Ex data class is the Inv_Processor_Ex table in the CMDB. Each data class has
a set of attributes that define its properties.

Table 6-2 Example of attributes of the Processor Extension data class

DescriptionAttribute

Specifies the unique index that is used to identify the device.Device ID

Specifies the size of the Level 2 processor cache in kilobytes.L2 Cache Size

Specifies the clock speed of the Level 2 processor cache in megahertz.L2 Cache Speed

You can create a data class, and then add, edit, or delete its attributes. A configured data class
is referred to as a custom data class.

See “Creating and configuring a data class” on page 79.

After you configure a data class, you can create a task, configure the task script, and roll it out
to the managed computers.

See “Creating a custom inventory script task” on page 81.

The custom inventory script task that runs on the managed computers generates a Notification
Server Event (NSE) that contains inventory for a data class. A unique GUID identifies each
data class. The inventory in the NSE is coupled with the GUID of a data class. For Windows
platforms, the NSE loads the inventory in the data class that has the same GUID associated
with it. For UNIX, Linux, and Mac platforms, the data class name is used instead of the GUID
to identify the data class in which to store the collected inventory information

Note: The script that gathers inventory on Windows computers contains a reference to the
GUID of a custom data class. Every time you create or edit an existing custom data class, a
new GUID is assigned to this data class. You must manually update the script with the new
GUID, if it refers to the older GUID for the same custom data class.

Creating and configuring a data class
In the Symantec Management Console, you can create a custom data class, add, edit, and
delete data class attributes, and change the position of the attribute. You can also find the
GUID and view the data in the data class.

Note that every time you modify an attribute and save the changes, a new GUID is assigned
to this data class.

See “About custom inventory data classes” on page 79.
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See “About gathering custom inventory” on page 77.

See “Gathering custom inventory” on page 78.

For more information, see the topics about custom inventory data classes and about gathering
custom inventory in the Inventory Solution User Guide.

Before you perform this step, ensure that you have prepared managed computers for inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To create and configure a data class

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, expandDiscovery and Inventory > Inventory Solution,
and then click Manage Custom Data classes.

3 To create a data class, do the following:

■ On the Manage Custom Data Classes page, click New data class.

■ On the New Data Class page, type a name and a description for the data class, and
then click OK.
The name of the new data class must be unique.

4 To configure a data class, on theManage CustomData Classes page, in the data classes
list, click the data class.

You can add data class attributes, edit, or delete them.

5 (Optional) To add an attribute to the data class, do the following:

■ On the toolbar, click Add attribute.

■ In the Data Class Attributes dialog box, specify the details of the attribute.
To add an attribute that uniquely defines a row in the data class, in the Key drop-down
list, click Yes. After you do this, the attribute always has a unique value that is other
than NULL.
To add an attribute that should never be empty or blank, in the Data required
drop-down list, click Yes.
If, in the Key drop-down list, you click Yes, the Data required option is automatically
set to Yes. To change this option, in the Key drop-down list, click No.

■ Click OK.

6 (Optional) To edit or delete the data class attributes, the attribute, and then, on the toolbar,
click the Edit or Delete symbol.

7 (Optional) To let the data class store inventory of multiple objects, on theManage Custom
Data Classes page, checkAllowmultiple rows from a single computer resource. The
data class can store the inventory of services, user accounts, files, network cards, and
other objects.
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8 (Optional) To specify the sequence of the attributes, on theManage CustomData Classes
page, click an attribute, and then click the up arrow or down arrow.

When you report inventory values for the columns in a Notification Server Event (NSE),
the attributes are identified by the column ID instead of the column name, so the order of
attributes in a data class must be correct

9 Click Save changes.

10 (Optional) Copy and paste the GUID of the data class that you created for further use.

The next step is to create a custom inventory script task.

See “Creating a custom inventory script task” on page 81.

Creating a custom inventory script task
After you have created the custom inventory data class, you create and configure a custom
inventory script task that gathers the custom inventory.

See “Creating and configuring a data class” on page 79.

To create a custom inventory script task, you can clone a sample script task and configure it
with the custom data classes that you created. You can also create and configure a custom
inventory script task on the Jobs and Tasks portal page.

When you configure your custom inventory script, you can insert tokens in the script and create
or edit tokens.

For more information, see the topics about the Run script task page and the Tokens page
in the IT Management Suite Administration Guide.

Note: The process of creating a custom inventory script task is the same across all platforms:
Windows, UNIX, Linux, and Mac. However, the scripting language and the logic that is used
in the scripts are different.

See “About gathering custom inventory” on page 77.

See “Gathering custom inventory” on page 78.

To clone a sample custom inventory script task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, under Jobs and Tasks, expand Samples > Discovery and Inventory
> Inventory samples > Custom.

3 Right-click the sample custom inventory script task, and then click Clone.

4 In the Clone dialog box, give the cloned script a descriptive name and click OK.
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5 (Optional) Configure the sample script, and then click Save changes.

See “Configuring the custom inventory sample script for Windows” on page 83.

See “Configuring the custom inventory sample script for UNIX, Linux, and Mac” on page 84.

6 Under Task Status, do one of the following:

■ To schedule the task to run on managed computers, click New Schedule.

■ To perform a quick run of the task on managed computers, click Quick Run.

7 Click Save changes.

To create a custom inventory script task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, navigate to the folder where you want to create a custom inventory script
task, right-click the folder, and then click New > Task.

For example, to create a task in the Jobs and Tasks folder, right-click Jobs and Tasks,
and then click New > Task.

To create a task in the Inventory folder, expand Jobs and Tasks > System Jobs and
Tasks > Discovery and Inventory, right-click Inventory, and then click New > Task.

3 In the Create New Task dialog box, in the left pane, click Run Script.

4 In the right pane, type a descriptive name for the task.

5 In the Script type drop-down list, click the script type.

6 Enter your own script or copy a sample custom inventory script to the script editor.

To insert a token to your custom inventory script, do the following:

■ In the Insert token drop-down list, click the token that you want to insert.

■ Click Insert.

To access a sample custom inventory script, do the following:

■ In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

■ In the left pane, under Jobs and Tasks, expand Samples > Discovery and Inventory
> Inventory samples > Custom.

7 (Optional) In the Create New Task dialog box, in the script editor, configure the script.

See “Configuring the custom inventory sample script for Windows” on page 83.

See “Configuring the custom inventory sample script for UNIX, Linux, and Mac” on page 84.

8 (Optional) To configure the advanced options for running the custom inventory script task,
do the following:
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■ Click Advanced, and then, on the Script tab, configure the options according to your
needs.

■ In the Task options tab, configure the settings for running the script task, and the
maximum possible length of the script task.

■ Click OK.

9 In the Create New Task dialog box, click OK.

10 On the Run Script page, under Task Status, do one of the following:

■ To schedule the task to run on managed computers, click New Schedule.

■ To perform a quick run of the task on managed computers, click Quick Run.

11 Click Save changes.

The next step is to wait for the client computers to receive the new task and report the results,
and then view the data that is stored in the Configuration Management Database (CMDB).

See “Viewing inventory data in the Resource Manager” on page 145.

Configuring the custom inventory sample script for Windows
Symantec recommends that you clone the existing custom inventory script task sample, and
then configure it according to your needs. The sample script for Windows already contains the
required code for a WMI query. You only need to add your own logic to gather the necessary
data and to populate the attribute variables in the script.

See “Creating a custom inventory script task” on page 81.

See “Gathering custom inventory” on page 78.

To configure the custom inventory sample script for Windows

1 Clone or open an existing sample of the custom inventory script task.

2 Specify the values that you want to gather.

Example:

strComputer = "."

Set objWMIService = GetObject("winmgmts:" &

"{impersonationLevel=impersonate}!\\" & strComputer & "\root\cimv2")

'Fire WMI Query

Set objCIMObj = objWMIService.ExecQuery("select * from CIM_processor")

3 Replace the GUID in the script with the GUID of the data class that you created.

Example:
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set objDCInstance = nse.AddDataClass ("{e8220123-4987-4b5e-bc39-

ec6eaea312ef}")

To access the GUID of the data class that you created, do the following:

■ In the Symantec Management Console, on the Settings menu, click All Settings.

■ In the left pane, under Settings, expand Discovery and Inventory > Inventory
Solution, and then click Manage Custom Data classes.

■ On the Manage Custom Data Classes page, click the data class, and then, under
Manage Custom Data Classes, on the toolbar, click the Details symbol.

4 Update attributes of the data class.

Example:

For each objInfo in objCIMObj

'Add a new row

dim objDataRow

set objDataRow = objDataClass.AddRow

'Set columns

objDataRow.SetField 0, objInfo.DeviceID

objDataRow.SetField 1, objInfo.L2CacheSize

objDataRow.SetField 2, objInfo.L2CacheSpeed

Next

5 Click Save changes.

Configuring the custom inventory sample script for UNIX, Linux, and
Mac

The custom inventory script for UNIX, Linux, and Mac generates a text output that contains
the collected inventory data in a specified format. This data is used to create the NSE and is
posted into the Configuration Management Database (CMDB). The logic of creating the NSE
and posting the data is hidden from the user.

When you configure the sample script, you can modify the output that the script generates.

See “Creating a custom inventory script task” on page 81.

See “Gathering custom inventory” on page 78.
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To configure the custom inventory sample script for UNIX, Linux, and Mac

1 Clone or open an existing sample of the custom inventory script task.

Do not change the first lines of the script. Make changes after the # SCRIPT_BEGINS_HERE

label.

2 Specify the data class.

Example:

echo UNIX_PS_List

3 Specify the delimiters.

Example:

echo "Delimiters=\" \" "

4 Specify the data type and the length of each column.

Example:

echo string20 string20 string20 string256

5 Specify the column names.

Example:

echo PID Terminal Time Command

Note that the column names are left for backward compatibility with 6.x Inventory Solution.
You can leave this line empty in 7.x or later, but keep the echo command intact.

Example:

echo

6 Specify commands to retrieve data from system.

Example:

ps -ef

7 Click Save changes.
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Gathering software
inventory

This chapter includes the following topics:

■ About gathering software inventory

■ Gathering software inventory

■ Methods for gathering software inventory

■ How software inventory rules work

■ About targeted software inventory

■ Running a targeted software inventory

■ About software inventory using the filescan.rule file

■ Running software inventory on UNIX, Linux and Mac computers using the filescan.rule file

■ About Software Catalog Data Provider

■ Configuring the schedule for the Software Catalog Data Provider Inventory task

■ Configuring the schedule for the Software Catalog Data Provider task

About gathering software inventory
Software inventory collects information about the applications that are installed on your managed
computers to help you analyze different aspects of your resources.

For example, you can identify the computers that do not meet minimum security requirements,
do not have antivirus software or application updates installed. You can also find out the
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number of installed instances of an application to prepare for a software license audit, or check
whether a specific software is installed on your managed computers

Software inventory tasks or policies scan the managed computers for the available software
applications, and then report the collected information to Notification Server. You can collect
information about both standard applications and custom software applications that are installed
on your managed computers.

The installed software that you can identify on your managed computers is defined as a software
component. You can have software components automatically associated with the predefined
software products that Inventory Solution provides. In this way, Inventory Solution lets you
manage and track software usage at the product level instead of the file level. For example,
you can manage Microsoft Office 2008 as a software product, and see it in reports as Microsoft
Office 2008, not as winword.exe.

For more information, see the topics about managing software in the IT Management Suite
Administration Guide.

See “About targeted software inventory” on page 94.

See “Configuring the schedule for the Software Catalog Data Provider Inventory task”
on page 100.

See “About viewing inventory data” on page 142.

Gathering software inventory
Software inventory gathers information about the standard and the custom software applications
that are installed on your computers. Software inventory data helps you analyze different
aspects of your resources.

Table 7-1 Process for gathering software inventory

DescriptionActionStep

Target computers must be managed and have the Inventory
Plug-in installed.

See “Preparing managed computers for inventory and metering”
on page 35.

The Symantec Management Agent and the Inventory Plug-in are
not required on Windows computers if you use the stand-alone
inventory packages for the following purposes:

■ To gather basic software application file inventory
■ To gather inventory of Windows Add or Remove Programs

list

(Optional for Windows computers)
Prepare managed computers for
inventory.

Step 1
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Table 7-1 Process for gathering software inventory (continued)

DescriptionActionStep

You can use different methods to gather different types of software
data:

■ Basic software application file inventory
■ Inventory of Windows Add or Remove Programs list and

UNIX/Linux/Mac software packages
■ Time-critical inventory that gathers the most important software

inventory data on client computers frequently during a day.
This inventory type has the real-time inventory option that
gathers software inventory on Windows client computers in
real time to validate the current software state.
See “About predefined inventory policies” on page 47.

■ Targeted software inventory on Windows computers and
software inventory using the filescan.rule file on UNIX,
Linux, and Mac computers

■ Gathering and validation of software information with the
Software Catalog Data Provider

See “Methods for gathering software inventory” on page 88.

Use the software inventory method
that meets your needs.

Step 2

You can view the gathered software inventory data in the inventory
reports, the Resource Manager, and the Symantec Management
Console Software views.

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views”
on page 146.

View software inventory results.Step 3

Methods for gathering software inventory
You can gather inventory about the software applications that are installed in your environment.
For example, you can gather information about the application version, build number, and
manufacturer.

Note: If a manufacturer does not provide the version of the software, a version is not populated
for the relevant software component.

When you perform a software inventory, you can use different methods to gather different
types of data.
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Table 7-2 Methods for gathering software inventory

DescriptionMethod

This software inventory method scans the file system on managed computers and
reports software inventory based on the software application .EXE files that are found.
For example, it reports file name, size, path, and so on.

To gather basic software application file inventory on managed Windows and UNIX,
Linux, and Mac computers, you create, configure, and turn on the inventory policy with
the File Properties - manufacturer, version, size, internal name, etc. box checked.

See “Creating and configuring inventory policies and tasks” on page 43.

See “How software inventory rules work” on page 92.

To gather standalone inventory of file properties on unmanaged Windows computers,
you create, configure, and run the stand-alone inventory package with the File
Properties - manufacturer, version, size, internal name, etc. box checked.

See “Creating, editing, or cloning stand-alone inventory packages” on page 58.

See “Running stand-alone inventory packages on target computers” on page 62.

Inventory of file properties
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Table 7-2 Methods for gathering software inventory (continued)

DescriptionMethod

This software inventory method uses the Software Management Framework agent to
collect the information about the installed software applications. If Inventory Solution
is not installed, the Software Discovery scan collects the data. When Inventory Solution
is installed, the Inventory policies and tasks are used for this purpose.

On Windows computers, you can gather information about the following applications:

■ The applications in theAdd or Remove Programs list of managed computers (MSI
cache).

■ Microsoft Application Virtualization (App-V) virtual applications
■ Microsoft Windows store applications

On UNIX, Linux, and Mac computers, you can gather information about the software
packages on managed computers.

Inventory Solution also uses the Software Management Framework agent to collect
the information about the key program files for the Windows applications that are
installed with an MSI-based installer. Gathered software inventory data helps you track
usage of a software product.

See “How the intelligent software identification works” on page 109.

To use this method on managed Windows, UNIX, Linux, and Mac computers, you
create, configure, and turn on the inventory policy with the Software – Windows
Add/Remove Programs and UNIX/Linux/Mac software packages box checked.
This box is checked by default.

See “Creating and configuring inventory policies and tasks” on page 43.

To use this method on unmanaged Windows computers, you create, configure, and
run the stand-alone inventory package with the Software – Windows Add/Remove
Programs box checked.

See “Creating, editing, or cloning stand-alone inventory packages” on page 58.

See “Running stand-alone inventory packages on target computers” on page 62.

Software inventory of
Windows Add or Remove
Programs list and
UNIX/Linux/Mac software
packages
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Table 7-2 Methods for gathering software inventory (continued)

DescriptionMethod

(Windows only)

Real-time inventory gathers software inventory on Windows client computers in real
time to validate the current software state.

Real-time inventory does the following:

■ Monitors the software state on target Windows client computers.
■ Invokes the software inventory scan within 10 minutes as soon as software is

installed or removed.
■ If the software state changes, sends delta inventory and data recency information

to Notification Server.
■ If no changes are found, sends data recency information to Notification Server.

To use this method on managed Windows computers, you turn on the Collect
Time-Critical Inventory policy with the Report real-time software inventory
(Windows only) box checked.

Real-time inventory

On managed Windows computers, this software inventory method lets you use rules
to identify specific software applications.

To use this method, you run the Targeted Software Inventory policy.

See “Running a targeted software inventory” on page 95.

On managed UNIX, Linux, and Mac computers, this method lets you collect information
about the installed software applications using the filescan.rule file. The software
inventory agent compares a list of applications in the filescan.rule file with the
actual file system data to determine which applications are installed.

See “Running software inventory on UNIX, Linux and Mac computers using the
filescan.rule file” on page 97.

Targeted software inventory
on Windows computers

Software inventory using the
filescan.rule file on
UNIX, Linux, and Mac
computers

The Software Catalog Data Provider is a component of Inventory Solution that can be
used to import software inventory data into the Software Catalog. The Software Catalog
Data Provider is installed with Inventory Solution.

The Software Catalog Data Provider provides a list of known software applications and
predefined software products that is imported in the Configuration Management
Database (CMDB). When you perform software inventory, the gathered data about
software applications can be compared to the list of known applications and predefined
software products. If the application data matches, it helps ensure that your software
inventory data is accurate and lets you manage installed software at the product level.

See “About Software Catalog Data Provider” on page 98.

Gathering software
information and validating it
using the Software Catalog
Data Provider

(Windows only)

See “About gathering software inventory” on page 86.
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How software inventory rules work
When you create inventory policies and tasks with the File Properties - manufacturer, version,
size, internal name, etc. box checked, you can configure the software inventory rules by
clicking Advanced > Files Properties Scan Settings on the inventory policy or task page.

See “Methods for gathering software inventory” on page 88.

The software inventory rules let you filter drives, system types, folders, and files when you
gather software inventory. By default, all local drives and all folders on those drives are scanned.
When you select a folder, all subfolders are included by default. You can add, edit, or delete
items in the list.

The following table explains how the software inventory Include and Exclude rules work.

Table 7-3 Software inventory include and exclude rules

DescriptionOption

Includes the drive in the scope of software scan.Drives > Include drive

Ignores the drive from software scan.Drives > Exclude drive

For the managed UNIX and Linux computers. This setting includes the
file system of the given type in the scope of software scan.

Drives > Include file system
type

For the managed UNIX and Linux computers. This setting excludes the
file systems of the given type from software scan.

Drives > Exclude file
system type

Includes the folder in the scope of software scan.Folders > Include folder

Excludes the folder from software scan. The folder can be specified as
an absolute, relative path or using a wildcard masks.

Folders > Exclude folder

For the managed UNIX and Linux computers. This setting tells the
software scan to limit maximum number of subfolder levels or to ignore
a folder where the count of files exceeds the given number.

Folders > Include folder
limits

Scans the files that match the given rules. Reports the size and the file
count information if you checkReport size/file count only in the Include
file rules dialog box. Otherwise, reports file information (name, path, size,
last modified date, manufacturer and so on).

File > Include Rule

Does not report the information about the files matching these rules to
the CMDB.

File > Exclude Rule

The following table explains how the Inventory Plug-in behaves on different platforms.
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Table 7-4 Software inventory behavior on different platforms

Behavior of the software
scan agent on Mac

Behavior of the software
scanagentonUNIX/Linux

Behavior of the software
scan agent on Windows

Possible settings on the
Files Properties Scan
Settings tab

Displays a message "Please
include at least one Drive or
Folder for the Mac scan."

Displays a message "Please
include at least one Drive or
Folder for the UNIX/Linux
scan."

Displays a message "Please
include at least one Drive or
Folder for the Windows
scan."

Does not include or exclude
any drives or file system
types and folders.

Scans the included drives.N/AScans the included drives.Includes only the drives, and
does not exclude any drives.
Does not include or exclude
any folders.

N/ADoes not scan anythingN/AIncludes only a file system
type, and does not exclude
any file systems. Does not
include or exclude any
folders.

Scans only the included
folders.

Scans only the included
folders.

Scans only the included
folders.

Includes only the folders and
does not exclude any
folders. Does not include or
exclude any drives or file
system types.

Scans the included child
folder.

Scans the included child
folder.

Does not scan the child
folder.

Excludes a parent folder, but
includes a child folder in it.

Scans the parent folder, but
ignores the child folder.

Scans the parent folder, but
ignores the child folder.

Scans the parent folder, but
ignores the child folder.

Includes a parent folder, but
excludes a child folder in it.

Scans only the included
folder.

N/AScans only the included
folder.

Excludes a parent drive, but
includes a folder on it.

N/ADoes not scan the included
folder.

N/AExcludes a file system type,
but includes a folder with
this file system type.

Scans the entire drive but
ignores the excluded folder.

N/AScans the entire drive but
ignores the excluded folder.

Includes a parent drive, but
excludes a folder on it.

N/ADoes not scan anythingN/AIncludes a file system type,
but excludes a folder with
this file system type.
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Table 7-4 Software inventory behavior on different platforms (continued)

Behavior of the software
scan agent on Mac

Behavior of the software
scanagentonUNIX/Linux

Behavior of the software
scan agent on Windows

Possible settings on the
Files Properties Scan
Settings tab

Does not scan any files.Does not scan any files.Does or does not exclude
files.

Does not include any files.

The included files are
scanned in the scope that
the drives and folders
define.

The included files are
scanned in the scope that
the file system types and
folders define.

The included files are
scanned in the scope that
drives and folders define.

Includes some files, and
does not exclude any files.

Files not matching the
criteria of the excluded files
and matching the criteria of
the included files criteria are
reported to the CMDB.

Files not matching the
criteria of the excluded files
and matching the criteria of
the included files are
reported to the CMDB.

Scans the files matching the
criteria of the included files.

Out of these, those matching
the criteria of the excluded
files are excluded from
reporting to the CMDB.

Includes some files, and
also excludes some files.

About targeted software inventory
This type of inventory is for Windows computers only.

Targeted software inventory feature determines whether a specific software is installed on
managed computers. To find the software, it uses the software resource and detection rule
information that is defined in the Software Catalog. This feature works with Windows computers
only.

See “Methods for gathering software inventory” on page 88.

See “Running a targeted software inventory” on page 95.

To find the software, targeted software inventory feature uses the following information that is
defined in the Software Catalog:

■ Software resource.
A software resource consists of the metadata that describes a specific instance of a software
application. A software resource is associated with the physical package file that installs
the software. On the Targeted Software Inventory policy page, you specify the software
that you want to inventory. The policy then reports the computers that contain the software.

■ The detection rule of a software resource.
The detection rule that is associated with a software resource can be used to create a
policy to determine if that software resource is installed on a given computer.

■ The file associations of a software resource.
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The files that are associated with a software resource can be used to analyze the Inventory
Solution file scan data to determine what software is installed on a given computer.

You can use the software information that is defined in the Software Catalog to determine
whether a specific software is installed on one or more managed computers.

The Targeted Software Inventory policy populates the inventory cache on each managed
computer with the currently installed software data. That data is communicated to the Notification
Server computer.

The software that you inventory must be defined as a software resource in the Software Catalog.
It must also have at least one detection rule.

You can see the results of the Targeted Software Inventory in the Installed Software report.
This report lists the software that is marked as installed, its version, count, and company name.
To view additional details such as the computers on which the software is installed, its user
account, and domain, right-click the software, and then click View Details. You access the
Installed Software report from theReportsmenu, atAll Reports > Discovery and Inventory
> Inventory > Cross-platform > Software/Applications > Software. You can also access
this report from the Resource Manager.

See “Viewing inventory data in the Resource Manager” on page 145.

See “About viewing inventory data” on page 142.

See “Configuring the schedule for the Software Catalog Data Provider Inventory task”
on page 100.

See “About gathering software inventory” on page 86.

Running a targeted software inventory
This type of inventory is for Windows computers only.

Targeted software inventory determines whether specific software is installed on managed
computers. To find the software, it uses the software resource and detection rule information
that is defined in the Software Catalog.

See “About targeted software inventory” on page 94.

Before you perform this step, ensure that you have prepared the managed computers for
inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To run a targeted software inventory

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, expand Discovery and Inventory.
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3 Right-click Targeted Software Inventory, and then click New > Targeted Software
Inventory.

4 On the New Targeted Software Inventory page, do the following

Type a name for this policy.

Because the description does not always appear, make the name descriptive
enough to easily identify this policy.

Policy name

Type a description to further identify this policy.Add description

5 Under Software to inventory section, on the toolbar, click Select Software.

6 In the Select Software dialog box, in the Available software list, click one or more
software resources, add them to the Selected software list, and then click OK.

7 To edit the detection rule for a software resource, under the Software to inventory, click
the software resource, and then click Edit Rule.

For more information, see the topics about creating or editing inventory rules in the IT
Management Suite Administration Guide.

8 On the policy page, expand the Schedule section, and then configure the policy schedule.

9 Expand the Applied to section, and then click the managed computers that you want to
apply the policy to.

10 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

11 Click Save changes.

The next step is to wait for the client computers to receive the new policy and report the
inventory results, and then view the data that is stored in the Configuration Management
Database (CMDB).

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views” on page 146.

About software inventory using the filescan.rule
file

Software inventory using the filescan.rule file lets you collect information about the installed
applications on your UNIX, Linux, and Mac computers.
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A file scan agent that is included in software inventory uses the filescan.rule file to detect
the applications that are installed on your managed computers. The filescan.rule file contains
the data sets that represent information about different applications. The file scan agent
compares each data set to the actual file system data to find out whether an application is
installed.

See “Running software inventory on UNIX, Linux and Mac computers using the filescan.rule

file” on page 97.

Each data set in the filescan.rule file consists of two lines of data. The first line is the
application description data, and the second line is the matching criteria data. The application
description data consists of the product name, the manufacturer, the version, and the description
of the application. The matching criteria data includes a file name or the absolute path to the
file that is part of the application, file size, and cyclic redundancy check (CRC). When the file
scan agent finds this file in the specified directories, the associated product is reported as part
of the inventory on that system.

A data set that represents information about an application in the filescan.rule file looks as
follows:

product name = "Watcher" manufacturer = "Company" version = "3.24" description

= ""

file = "/opt/secret/eys/watcher" size = "45698" CRC = ""

A default filescan.rule file is included in the Inventory Plug-in installation package for each
platform. It contains an example list of some common applications.

Symantec recommends that you configure the default filescan.rule file to include the
additional applications that the software inventory should report. You can also add entries for
the applications that are developed in-house.

After you configure the filescan.rule file, you can create a Quick Delivery task to redistribute
it to all managed UNIX, Linux, and Mac computers.

For more information, see the topics about creating a Quick Delivery task in the Software
Management Solution User Guide.

See “About gathering software inventory” on page 86.

Running software inventory on UNIX, Linux and Mac
computers using the filescan.rule file

To run the software inventory using the filescan.rule file, you must have the Symantec
Management Agent and the Inventory Plug-in installed on your managed UNIX, Linux, and
Mac computers. The Inventory Plug-in installation package includes a default filescan.rule
file that contains an example list of some common applications.
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You can configure the default filescan.rule file and add the applications that you want to
be reported. You can also use the aex-filesurveyor utility to scan your UNIX, Linux, and Mac
systems for executables. The output of the scan is formatted for use as a filescan.rule file.
After you create or configure a filescan.rule file, you can distribute it to the managed
computers.

The file scan agent uses the settings of the Inventory task or policy to scan the directories. If
you want to change the set of the directories that are scanned, you must configure the advanced
settings of the Inventory task or policy. If you do not specify any directories, then all local drives
are scanned.

See “About software inventory using the filescan.rule file” on page 96.

Before you perform this step, ensure that you have prepared the managed computers for
inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To run software inventory using filescan.rule file

1 (Optional) Copy the default filescan.rule file from the managed computer to the
Notification Server computer and configure it.

2 (Optional) To distribute the configured filescan.rule file to the managed computers,
create a Quick Delivery task in the Symantec Management Console.

Copy the filescan.rule file to the following folder:

/opt/altiris/notification/inventory/etc/

You can use the following universal path with custom installation directories:

`aex-helper info path -s INVENTORY`/etc/

For more information, see the topics about creating aQuick Delivery task in the Software
Management Solution User Guide

3 For the Inventory policy that gathers software inventory, ensure that you check the File
properties - manufacturer, version, size, internal name, etc. box.

The next step is to view inventory results.

See “Viewing inventory data in reports” on page 143.

See “Viewing inventory data in the Resource Manager” on page 145.

See “Viewing inventory data in Computers and Software views” on page 146.

About Software Catalog Data Provider
This is applicable to Windows computers only.
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The Software Catalog Data Provider (SCDP) is a component of Inventory Solution that can
be used to identify the software that has been detected on the client computers in your
environment and that cannot be identified otherwise. For example, components that were not
installed with an MSI-based installer and cannot be found in the Add/Remove Programs list.

TheSoftware CatalogData Provider Inventory task identifies installed software and compares
the information gathered by software inventory to the lists of known applications (software
components) that is provided by SCDP. If a match is found, the software component can be
created and imported into the Software Catalog. You can then manage your installed software.

See “Managing software using a predefined nightly task ” on page 110.

The Software Catalog Data Provider Inventory task is not enabled by default. To control
which data is imported into the Software Catalog, you can schedule the task according to your
needs.

Note: The software in your environment can be detected either by running a software scan or
with the help of SCDP. If both methods are used at the same time, duplicate software
components can be created. Symantec recommends that you choose only one of these
methods and disable the other. The preferred method is to run a software scan.

Table 7-5 Components of Software Catalog Data Provider

DescriptionComponent

An .xml file that contains a list of software resources.

To view this file, do one of the following:

■ In the Symantec Management Console, on the
Settings menu, click Console > Views, and then, in
the left pane, click Software > Data Provider
Summary.

■ In the Symantec Management Console, on the
Settings menu, click All Settings > Software > Data
Provider > Data Provider Management, in the left
pane right-click Software Catalog Data Provider, and
then click View Data Provider Summary.

A list of known components (Data Provider Summary)
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Table 7-5 Components of Software Catalog Data Provider (continued)

DescriptionComponent

This task gathers information about known applications
that are available in Software Catalog Data Provider.

If you want to use SCDP for detecting the software in your
environment, you need to manually schedule this task with
the option Gather selected.

If Software Catalog Data Provider data file is updated,
you need to start this task manually with the option Gather
selected to update the list of known components in CMDB.

Warning: If you run this task with the option Import
selected, it results in a database with an excessive amount
of software components which may be very difficult to
manage.

See “Configuring the schedule for the Software Catalog
Data Provider task” on page 101.

Software Catalog Data Provider task

This task compares gathered software inventory data to
the list of known components (shown in Data Provider
Summary).

If the data matches, the Software Catalog Data Provider
task automatically runs for the matched components with
the Import option enabled and creates software
components with the minimum metadata (company
(vendor) name, software name, version, and language).

The Software Catalog Data Provider Inventory task is
not executed by default. To control when the task runs,
you can schedule the task according to your needs.

See “Configuring the schedule for the Software Catalog
Data Provider Inventory task” on page 100.

Software Catalog Data Provider Inventory task

Configuring the schedule for the Software Catalog
Data Provider Inventory task

This task compares gathered file properties inventory data to the list of known applications
that are available in Software Catalog Data Provider (SCDP).

If the data matches, the Software Catalog Data Provider task automatically runs for the
matched components with the Import option enabled and creates software components with
the minimum metadata (company (vendor) name, software name, version, and language).
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The Software Catalog Data Provider Inventory task is not executed by default. To control
when the task runs, you can schedule the task according to your needs.

To configure the schedule for Software Catalog Data Provider Inventory task

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Data Provider > Software Catalog
Data Provider Inventory.

3 Under Task Status, click New Schedule.

4 In the New Schedule dialog box, under Schedule, configure the schedule for the task,
and then click Schedule.

See “About Software Catalog Data Provider” on page 98.

This is applicable to Windows computers only.

Configuring the schedule for the Software Catalog
Data Provider task

This task gathers information about known applications that are available in Software Catalog
Data Provider (SCDP).

If you want to use SCDP for detecting the software in your environment, you need to manually
schedule this task with the option Gather selected.

If Software Catalog Data Provider data file is updated, you need to start this task manually
with the option Gather selected to update the list of known components in CMDB.

If the Software Catalog Data Provider Inventory task provides the data that matches the
known applications that are available in SCDP, the Software Catalog Data Provider task
does the following:

■ Runs automatically for the matched applications with the Import Data option selected.

■ Creates software components with the minimum metadata (company (vendor) name,
software name, version, and language).

See “About Software Catalog Data Provider” on page 98.

See “Configuring the schedule for the Software Catalog Data Provider Inventory task”
on page 100.

To configure the schedule for the Software Catalog Data Provider task

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, click Software > Data Provider > Providers > Software
Catalog Data Provider
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3 In the right pane, under Task Status, click New Schedule.

4 In the New Schedule dialog box, under Schedule, configure the schedule for the task.

5 Under Actions, select one of the following options:

■ To update the list of known components in the CMDB, click Gather.

Note: Select this option after SCDP is installed if you want to use SCDP for detecting
the software in your environment.

■ To manually create software components and import them into the Software Catalog,
click Import Data or Import Data and Package.

Warning: Symantec does not recommend creating a schedule for importing data from
SCDP. With a scheduled import, every software resource in SCDP is imported. It
results in a database with an excessive number of software components that are
difficult to manage.

6 Click Schedule.
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Software usage tracking,
application metering, and
application denial

This chapter includes the following topics:

■ About software usage tracking, application metering, and application denial

■ Software usage tracking

■ Metering applications

■ Denying applications

■ Configuring the purging settings for application metering data

■ Application summary data

About software usage tracking, applicationmetering,
and application denial

Inventory Solution lets you perform the following tasks on your managed Windows XP and
above client computers:

■ Track usage of the managed software at the software product level by enabling the software
usage tracking option.
This task is the primary method to use for the majority of software products.
See “Software usage tracking” on page 105.

■ Meter the use and control the availability of applications by running predefined or custom
application metering policies.
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Symantec recommends that you use this task only if you need to meter start, stop, and
denial events for applications at the file level.
See “Metering applications” on page 115.

■ Deny multiple applications from running by configuring the predefined Blacklisted
Applications policy or running custom application metering policies.
See “Denying applications” on page 125.

Inventory Solution lets you perform the following task on your managed Mac client computers:

■ Track usage of the managed software at the software product level by enabling the software
usage tracking option.
See “Software usage tracking” on page 105.

Note:Software-based usage tracking and application metering are not supported on Windows
and Mac servers.

To track usage of managed software products, meter, and deny applications, you must have
the Symantec Management Agent, Inventory Plug-in, and Application Metering Plug-in installed
on target computers. If only Application Metering plug-in is installed on the client computer,
but the Inventory plug-in is not, there are the following limitations:

■ You cannot gather information about installed software using Inventory policies and tasks.

■ You cannot track software products if the information about installed software is not
gathered.

■ The Underutilized Software report only shows the information about client computers on
which metered software has been recognized as installed.

See “Preparing managed computers for inventory and metering” on page 35.

In the application metering reports, you can view the following application metering data that
is recorded in the CMDB:

■ Which metered applications and managed software products were used

■ Application resource usage statistics

See “Viewing inventory data in reports” on page 143.

For example, you can view application summary data in the following application metering
reports:

■ The Executable Usage report displays the application summary data for Windows
applications that are defined and marked as allowed or denied in a turned on application
metering policy.
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■ TheUnderutilized Software report displays software product usage summary data for the
software products that are detected as installed on the managed Windows and Mac
computers.

See “Application summary data” on page 131.

If you enable the software-based usage tracking option for the managed software products,
you can also view the following usage tracking data in the Symantec Management Console
Software view:

■ License deployment
For more information, see the topics about managing software licenses in the Asset
Management Suite User Guide.

■ The usage of the software product

■ Last usage time

■ Installation date

See “Viewing inventory data in Computers and Software views” on page 146.

If you meter or deny applications using application metering policies and turn on the application
metering policy optionRecord usage events, you can view the usage events of the applications
that are defined in the policy. When you view a managed computer in the Resource Manager,
to view application metering start and stop events, you click View > Events, and then expand
Data Classes > Inventory > Application metering.

See “About application metering start, stop, and denial events” on page 123.

Software usage tracking
Software usage tracking is only available on Windows and Mac computers.

If you need to track application usage, the best practice is to use the software usage tracking
option that Inventory Solution provides.

You can manage software products, track software usage, and view gathered usage tracking
data in the Symantec Management Console Software view. You see the Software view if you
have installed the following:

■ Symantec Management Platform

■ Inventory Solution

■ Software Management Solution

■ ITMS Management Views

On Windows computers, you can track usage of the managed software at the software product
level. Inventory Solution uses inventory filtering criteria that are defined in software products.
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If a software component that is discovered in your environment matches the filtering criteria,
Inventory Solution associates the component to a relevant managed software product. Inventory
Solution also implements intelligent identification of software components and key program
files and creates component-to-file associations. When you enable usage tracking for a software
product, you specify usage tracking rules that define the program files that you want to track.
This way you can track software usage at the product level instead of the file level. For example,
you can track Microsoft Office 2008 as a separate software product. You can see it in usage
tracking reports as Microsoft Office 2008, not as winword.exe.

On Mac computers, you can track usage of the managed software at the software product
level. For software tracking on Mac computers, Inventory Solution uses inventory filtering
criteria that are defined in software products. Inventory Solution automatically associates all
relevant Mac applications with the corresponding software components of the software products.
These component-to-file associations are stored locally on the client Mac computers. The
associations are not sent to the CMDB and not displayed in the Symantec Management
Console. Inventory Solution uses the associations when you enable the usage tracking option
for a particular software product that has software components installed on Mac computers.

See “How the intelligent software identification works” on page 109.

The software-based usage tracking option also helps you to prepare for managing software
licenses and for software audit. It lets you see which software is installed and used in your
environment, and how many software licenses you use. For example, before the Adobe software
audit, you can view all the versions of Adobe products that are installed in the company
environment.

For more information, see the topics about managing software licenses in the Asset
Management Suite User Guide.

See “About software usage tracking, application metering, and application denial” on page 103.

Table 8-1 Process for software usage tracking

DescriptionActionStep

Target computers must be discovered, managed with the Symantec
Management Agent, and have the Inventory Plug-in and the Application
Metering Plug-in installed.

See “Preparing managed computers for inventory and metering”
on page 35.

Prepare computers for
tracking usage of the
managed software products.

Step 1
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Table 8-1 Process for software usage tracking (continued)

DescriptionActionStep

You can configure the purging settings for gathered application metering
data.

Application metering data that is older than two months is deleted by
default.

See “Configuring the purging settings for application metering data”
on page 130.

(Optional) Configure settings
for gathered application
metering data.

Step 2

If you use hierarchy with customized settings, ensure that the following
replication rules are enabled:

■ File Resources for key executable files
■ Metered Files Properties Data class data
■ Metering Summary Data class data
■ Software Component Resources for installed software components
■ Software Components
■ Software Products
■ Software Products and metering/track usage configuration for the

products

You enable the replication rules in the Symantec Management
Console, at Settings > Notification Server > Hierarchy > Hierarchy
Management > Replication > Resources.

note that if you track usage of the managed software products in
hierarchy with the default settings, these replication rules are enabled
by default.

(Optional) Ensure that the
proper replication rules are
enabled.

Step 3

You can track usage of software products that are installed and
discovered in your environment.

Use the following software inventory method to discover and gather the
required software inventory data:

Software inventory of Windows Add or Remove Programs list and
UNIX/Linux/Mac software packages

See “Methods for gathering software inventory” on page 88.

Gather software inventory.Step 4
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Table 8-1 Process for software usage tracking (continued)

DescriptionActionStep

You can track usage of a software product only if the software product
is managed.

After software inventory data is gathered and entered into the
Configuration Management Database (CMDB), you have the following
options for managing a software product and its components:

■ Inventory Solution provides the list of predefined managed software
products that have defined inventory filtering criteria. If the software
product that you want to track is predefined, Inventory Solution
automatically associates discovered and matching software
components with your product. The software component that gets
associated with a managed software product becomes a managed
component. Note that if you later decide to make the software
product unmanaged, the software components that belong to the
product become unmanaged.
The predefined nightly task ensures that each software component
is associated to an appropriate software product.
See “Managing software using a predefined nightly task ”
on page 110.

■ If the software component that you want to track does not belong
to the predefined software product, you can manually create a
managed software product for this software component.
See “Manually creating the managed software products” on page 111.

You view the managed software products in the Symantec
Management Console, when you clickManage > Software > Software
Catalog > Managed Products.

To view the software components of the predefined software products
in the Symantec Management Console, click Manage > Software >
All Software > All Software Products, click the relevant software
product in the content pane, and then, in the right pane, in the software
details flipbook, click Product Summary > Inventory.

Manage the software product
that you want to track.

Step 5

You need to enable the software usage tracking option for the managed
software that you want to track at the product level.

For Windows computers, you also need to manually add at least one
usage tracking rule for each software product that you want to track.

See “Tracking usage of the managed software products” on page 113.

Enable tracking usage of the
managed software products
for managed computers.

Step 6
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Table 8-1 Process for software usage tracking (continued)

DescriptionActionStep

In the Symantec Management Console Software view, you can track
the following usage events for the managed software products:

■ License deployment
For more information, see the topics about managing software
licenses in the Asset Management Suite User Guide.

■ The usage of the software application at the product level
■ Last usage time

Note: If an application is in use at the moment when the data is
gathered, the current time is reported as the last usage time.

■ Installation date

See “Viewing inventory data in Computers and Software views”
on page 146.

You can also view application summary data for the managed software
product in the following application metering reports:

■ (Windows only) Executable Usage
■ Underutilized Software

See “Viewing inventory data in reports” on page 143.

See “Application summary data” on page 131.

View usage tracking results.Step 7

How the intelligent software identification works
Software identification is only available on Windows and Mac computers.

You can track usage of a managed software product only if the software product has at least
one software component that is associated to it.

When Inventory Solution runs the software inventory scan on managed computers, it implements
intelligent identification of software components and key program files.

See “Methods for gathering software inventory” on page 88.

As a result of the identification process, the following key program files get automatically
associated with the relevant software components:

■ Mac program files

■ Windows program files that are installed with an MSI-based installer

Automatic association is the primary method to use for the majority of software products.

On managed Mac computers, Inventory Solution uses filtering criteria that are defined in
software products. Software Management Framework (SMF) agent scans the file system for
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installed application bundles and determines the key program files that are associated to each
software component. These component-to-file associations are stored locally on the client
Mac computers. The associations are not sent to the CMDB and not displayed in the Symantec
Management Console. Inventory Solution uses the associations when you enable the usage
tracking option for a particular software product that has software components installed on
Mac computers.

On managed Windows computers, the software identification process has the following steps:

■ Inventory Solution uses SMF agent to scan registry key entries and determine the software
components that are installed with an MSI-based installer.
SMF agent interrogates the cached MSI that is discovered during the scan and creates the
list of program files that are associated to the software component. These component-to-file
associations are stored in NSE files and sent to the CMDB.

■ Then SMF agent scans the .lnk (shortcut) files in the Start menu for the current user and
all users of managed computers to determine the program files that are used to launch the
software component of the software product.
If the program files have component-to-file association, such files become the key program
files for this component.
For example, winword.exe is the key program file for the software component Microsoft
Office Word that belongs to the software product Microsoft Office.
Inventory Solution uses the key program files data to create the predefined usage tracking
rules that you can select when you enable usage tracking.

See “Software usage tracking” on page 105.

Managing software using a predefined nightly task
Software management is only available on Windows and Mac computers.

The predefined nightly task NS.Nightly schedule to associate Software component to
software product ensures that each software component is associated to an appropriate
software product or is assigned the Newly Discovered Software status. To ensure the
responsiveness of the Console, some database updates are made when the configuration is
changed, and then the task completes the rest of the updates.

When you modify or delete a software product, Inventory Solution disassociates the software
components that no longer match the product.

The task NS.Nightly schedule to associate Software component to software product
runs automatically on the Notification Server computer every night at 12:30 A.M.

You may want to run the task manually if you have created one or more software products or
modified the software filtering rules, but the software components are still not associated with
the newly created or modified products.

This task is a step in the process for tracking the usage of the managed software products.
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See “Software usage tracking” on page 105.

Before you perform this step, ensure that you have gathered software inventory on the client
computers.

See “Gathering software inventory” on page 87.

To manually run the task NS.Nightly schedule to associate Software component to software
product

1 On the Notification Server computer, in the taskbar, click Start > Administrative Tools
> Task Scheduler.

2 On the Task Scheduler page, in the left pane, click Task Scheduler Library.

3 In the central pane, right-click the task NS.Nightly schedule to associate Software
component to software product, and then click Run.

The next step is to track the usage of the managed software products.

See “Software usage tracking” on page 105.

Manually creating the managed software products
On Windows XP and above client computers, you can track usage of managed software
products, meter, and deny applications.

On Mac client computers, you can track usage of managed software products.

Software usage tracking and application metering are not supported on Windows and Mac
servers.

You can track usage of a software product only if the software product is managed.

Inventory Solution provides the list of predefined software products. If discovered software
component matches software product from the list, software component is automatically
associated with the relevant predefined software product so you may manage it.

If the software component that you want to track does not match filtering criteria of any
predefined software product, you can manually create a managed software product for this
software component.

This task is a step in the process for tracking usage of the managed software products.

See “Software usage tracking” on page 105.

To manually create a managed software product for a discovered software component

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the Software pane, click Favorites > Discovered Unreviewed Software.

3 In the content pane, select the software component for which you want to create a software
product.
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4 In the right pane, under Software Release Summary, click Manage this software.

5 In the Manage Software Component - Define Product dialog box, click one of the
following options, and then perform the required actions:

1 View the software component details, and then click Next.

2 In theManage Software Component - Define Product Properties dialog
box, view or edit the software component properties, and then click Next.

Create a new
software product
for this software
component

Select an existing software product that you want to associate with the software
component, and then click Next.

Associate this
software
component with
an existing
software product

6 (Optional for a new product) In the Manage Software Component - Define Product
Inventory dialog box, perform the following actions:

■ To edit filtering criteria, enter new criteria in the Software name,Company, or Version
filters.
Note that the Company filter works only after you enter criteria in the Software name
filter.
The filtering inventory rules define the software product and the software components
that can be associated to it. The filtering inventory rules are dynamic. Any software
component that comes into your environment and matches these rules is automatically
associated to this software product. For example, you can change the Software name
from Adobe Reader to Adobe, and the details in the Identify inventory tab change
to display software components for all Adobe products.
If your software component does not match the filter criteria of the selected existing
software product, the component is highlighted in red. To proceed with associating
the component with the selected product, you need to edit the filtering inventory rules
of the product.

Warning: If you modify filter criteria of a predefined software product, the product will
not be updated with future product definitions provided by Symantec.

If the product already has associated software components that do not match the
modified filter criteria, such components are grayed out. After you save the changes,
such components are excluded from product associations.
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■ To include the software components that are associated with other software products,
check Include components associated with other products. The components that
are associated with other software products are highlighted in yellow.

7 Click Create or Save.

The next step is to track the usage of the managed software products.

Tracking usage of the managed software products
Software tracking is only available on Windows and Mac computers.

Inventory Solution provides the usage tracking option to help you track software usage at the
product level and prepare for managing software licenses.

You can track usage of a software product only if the software product meets the following
requirements:

■ A software product is installed and discovered in your environment.

■ A software product is managed in the Software Catalog and has at least one software
component that is associated to it.

■ The usage tracking option is enabled for a software product.

■ (Windows only) A software product has at least one usage tracking rule.

Note: You can configure tracking usage of a newly created managed software product before
the inventory data for this product is gathered in your environment.

This task is a step in the process for software usage tracking.

See “Software usage tracking” on page 105.

Before you perform this step, ensure that the managed software product that you want to track
has the software components that are associated to it.

See “Managing software using a predefined nightly task ” on page 110.

See “Manually creating the managed software products” on page 111.

You view the managed software products in the Symantec Management Console, when you
click Manage > Software Catalog > Managed Products.

To track usage of the managed software products

1 In the Symantec Management Console, on the Manage menu, click Software Catalog.

2 In the Software pane, in the Software Catalog folder, click Managed Products.

3 In the Managed Products pane, click the software product that you want to track.
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4 In the right pane, in the software details flipbook, click Product Summary > Usage
Tracking.

5 On the Usage Tracking page, enable the usage tracking option.

6 In the Count software as used if run in the last ... days box, type the number of days.

7 (Windows only) To add a usage tracking rule for the software product that you want to
track, perform the following steps in order:

■ In the upper left corner of the table, click the Add usage tracking rule icon.

■ In the Add Usage Tracking Rule dialog box, click one of the following options, and
then preform the required actions:

A usage tracking rule consists of program file data. Define the file data as
follows:
■ Type a valid program file name (.exe).

Note that the file name cannot contain the following characters: \/:*?"<>|
■ Type a program file version.

Note: For usage tracking, Inventory Solution uses the binary
representation of the file version in the program file.

You can use wildcards (‘*’) in the Version field to broaden the scope
of the rule. If you do not specify a version, Inventory Solution uses
wildcards by default.

Specify a custom
usage tracking
rule for the
software product

Select one or many predefined usage tracking rules.

The predefined usage tracking rules are based on the key program files
that are automatically associated with the software components of the new
or already metered software products.

See “How the intelligent software identification works” on page 109.

Select at least
one predefined
usage tracking
rule for the
software product

■ Click OK.

8 (Windows only, optional) To edit an added usage tracking rule, on the Usage Tracking
page, double-click the rule, in the Edit Usage Tracking Rule dialog box, edit the program
file name or version, and then click OK.

9 On the Usage Tracking page, click Save.

The next step is to wait for the client computers to report the specified software usage, and
then view the data that is stored in the Configuration Management Database (CMDB).

See “Viewing inventory data in Computers and Software views” on page 146.

See “Viewing inventory data in reports” on page 143.

See “Application summary data” on page 131.
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Metering applications
Application metering is only available on Windows computers.

Inventory Solution lets you meter the use and control the availability of applications at the file
level by running predefined or custom application metering policies on your managed computers.

The best practice is to use this functionality only if you need to meter start, stop, and denial
events for applications at the file level. In other cases, you use the software-based usage
tracking option.

See “Software usage tracking” on page 105.

When you configure an application metering policy, you define the applications you want to
meter by creating new or editing the existing application definitions.

See “About defining applications to meter or deny” on page 119.

Notification Server polices control the rules for metering applications. Application Metering
Plug-in that runs with the Symantec Management Agent on the target computer enforces the
properties of the policies. An application metering policy can meter one or more applications.

When an application starts on a managed computer, Application Metering Plug-in checks for
a turned on policy monitoring the application. If the plug-in finds a turned on application metering
policy, it performs the following functions:

■ Records the application summary data locally and sends this data to the Configuration
Management Database (CMDB) at the end of the application monitoring period.
See “Application summary data” on page 131.

■ Sends the event notifications to the CMDB as specified in the application metering policy.
It can send application start, stop, or denial events. It sends this information in batches at
a specified interval or every time the number of captured events reaches 10000.
See “About application metering start, stop, and denial events” on page 123.

■ Denies the use of the application if it is specified in the application metering policy.

Warning: Multiple application metering policies can monitor the same application. This may
cause erroneous data in reports or trigger duplicate notification policy actions.

See “About software usage tracking, application metering, and application denial” on page 103.
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Table 8-2 Process for metering applications

DescriptionActionStep

Target computers must be managed with the Symantec Management
Agent and have Inventory Plug-in and Application Metering Plug-in
installed.

See “Preparing managed computers for inventory and metering”
on page 35.

Prepare computers for
metering.

Step 1

You can configure the archiving and purging settings for gathered
application metering data.

See “Configuring the purging settings for application metering data”
on page 130.

You also need to configure mail server and address settings if you want
to send an email that reports the denied application event.

For more information see the topic about mail server and address
settings in the IT Management Suite Administration Guide.

(Optional) Configure settings
for gathered application
metering data and mail server
and address settings.

Step 2

To enable application metering, you can use different options based
on your needs:

■ You can use several predefined application metering policies if you
want to meter common applications like Microsoft Office products
at the file level. If you want to configure the predefined policies to
meet your needs, Symantec recommends that you clone an original
predefined policy, and then configure the copy.
See “Metering applications using predefined application metering
policies” on page 116.

■ You can create and configure new application metering polices if
you want to meter applications at the file level.
See “Metering applications using custom application metering
policies” on page 117.

Enable application metering
on managed computers.

Step 3

You can view metering data in application metering reports.

See “Viewing inventory data in reports” on page 143.

View application metering
results.

Step 4

Metering applications using predefined application metering policies
Application metering is only available on Windows computers.

You use several predefined application metering policies if you want to meter common
applications such as Microsoft Office products. You can configure predefined policies to meet
your needs. If you want to configure predefined policies, Symantec recommends that you
clone an original predefined policy and then configure the copy.
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For application metering policies to work, you must have the Symantec Management Agent
and Application Metering Plug-in installed on target computers.

This task is a step in the process for metering and denying applications.

See “Metering applications” on page 115.

Before you perform this step, ensure that you have prepared managed computers for metering.

See “Preparing managed computers for inventory and metering” on page 35.

To turn on predefined application metering policies

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, expand Software > Application Metering > Samples, and then click
the predefined application metering policy that you want to use.

3 On the policy page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

4 Click Save changes.

To clone and configure predefined application metering policies

1 In the Symantec Management Console, browse to the predefined application metering
policy that you want to clone.

2 Right-click the policy, and click Clone.

3 Give the cloned policy a unique name, and click OK.

4 On the policy page, configure the policy options according to your needs.

See “Metering applications using custom application metering policies” on page 117.

5 On the policy page, turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.

The next step is to wait for the client computers to receive the new policy and report the
specified software usage, and then view the data that is stored in the Configuration Management
Database (CMDB).

See “Viewing inventory data in reports” on page 143.

Metering applications using custom application metering policies
Application metering is only available on Windows computers.

You can meter applications on Windows computers by monitoring the use of software. To
meter applications, you create and configure the policies that run on managed computers.
You can meter one or more applications with one policy.
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For application metering policies to work, you must have Application Metering Plug-in installed
on target computers.

This task is a step in the process for metering applications.

See “Metering applications” on page 115.

Before you perform this step, ensure that you have prepared managed computers for metering.

See “Preparing managed computers for inventory and metering” on page 35.

To meter applications using custom application metering policies

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, expand Software > Application metering.

3 Right-click the Application metering folder, and then click New > Application metering
policy.

4 On the policy page, give the policy a unique name and description.

5 On the Software tab, select the applications you want to meter.

See “Defining applications to meter or deny” on page 121.

You can also edit application definitions or delete applications from the list.

6 On theOptions tab, configure the application metering options for the selected applications
as follows:

■ To configure when the applications in this policy can run, click Allow or Only deny
running.
For example, to allow an application to run only during specific time, click Only deny
running, in the drop-down list, click Specific days and times, and then configure the
hours and days according to your needs.

■ To track the usage events of the applications that are defined in the policy, check
Record usage events, and then, in the drop-down lists, specify the event types that
you want to record and the intervals when the records of events are sent to the
Configuration Management Database (CMDB).
For example, to record the start events and send the records to the CMDB at least
every day, check Record usage events, and then, in the drop-down lists, click Start
and Daily.

Note:Captured events may be sent more frequently than the specified interval. Sending
events is forced as soon as 10000 events are collected.

See “About application metering start, stop, and denial events” on page 123.
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■ To define the actions to be taken when a denied application attempts to run, under If
run attempted during deny hours, in the drop-down list, click No action or Send an
email.
For example, to send an email that reports the denied application event, in the
drop-down list, click Send an email, in theMail Settings dialog box, type the recipient's
email address in the E-mail ID field, type a subject and text for the email, and then
click OK.

■ To prompt a user with a message when the user attempts to start a denied application,
check the Inform user box. You can also type your own message. If you customize
the message, you can also use tags %FileName% and %PolicyName% as in the
default text. On the client computer, the tags are replaced by the actual names of the
blocked process and policy.

7 Click Apply to, and select the resources to which you want to apply the policy.

For more information, see the topics about specifying the targets of a policy and specifying
filtering rules in the IT Management Suite Administration Guide.

8 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

9 Click Save changes.

The next step is to wait for the client computers to receive the new policy and report the
specified software usage, and then view the data that is stored in the Configuration Management
Database (CMDB).

See “Viewing inventory data in reports” on page 143.

About defining applications to meter or deny
Application metering and denial is only available on Windows computers.

When you configure an application metering policy, you define the applications you want to
meter by creating new or editing the existing application definitions. You can use broad or
specific product definitions. For example, you can use one definition to meter all Microsoft
applications, or you can use a specific definition to meter Word version 12. The metering
options for each policy apply to all the applications you have added in the list for that policy.

See “About software usage tracking, application metering, and application denial” on page 103.

See “Defining applications to meter or deny” on page 121.

Several predefined application metering policies are included.

Each application that you define must have a set of definition details. The details include the
product name, file name, product version, product company, and so on. Application metering
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policies use these details to identify the applications to meter on target computers. You can
specify any number of these details.

To specify the details of the applications, you populate the fields in the Add Application Rule
dialog box. You can populate these fields manually or import them from a known application.
The application definition details correspond to the properties of an executable file.

On Windows XP, you can see the properties when you right-click an executable file, click
Properties, and then click the Version tab. On Windows 7, you can see the properties when
you right-click an executable file, click Properties, and then click the Details tab.

The file version in the executable file has two representations, binary and string. Application
Metering uses string representation. On Windows XP, you can see it in the Properties dialog
box, on the Version tab, in the Other version information box. On Windows 7 and later, you
can use the powershell (dir "<file name>").VersionInfo command to see the version.

After you add an application definition to a policy, it appears in the list on the Software tab of
the application metering policy page.

Table 8-3 Guidelines for specifying application definition details

DescriptionItem

For an application to be monitored, it must meet the criteria of all the fields. For example,
if you specify the File name and File version, only the applications that meet both of
these criteria are monitored. Unspecified fields are ignored. You can use the * wildcard
in these fields to represent any number of characters.

All fields must be met

Symantec recommends that you specify internal file properties rather than depend on
the file name. The internal file properties are compiled into the file and are not editable
by a user. The internal file properties are internal name, file version, company name,
product name, and product version. If you monitor the file name and the user renames
the file, your monitor policy will no longer work for that user.

Internal file properties

The definition detail fields are case-sensitive.Details are case-sensitive

Definition name is used in the definition list. Each definition must have a definition
name.

Specify a definition name
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Table 8-3 Guidelines for specifying application definition details (continued)

DescriptionItem

Application definitions may be version-specific. You can have a definition with a specific
version or you can specify no version at all. If you do not specify a version, all versions
of the application are metered.

The following examples illustrate the cases when you may or may not want to use
versions:

■ You want to monitor the general use of an application and want to track the usage
of any and all versions.
For example, you want to track the use of all versions of Adobe Acrobat Reader.
You create a rule for Acrobat, enter AcroRd32.exe, or its internal name, in the
file name field, and leave the version fields blank.

■ You want to monitor the use of each version of an application.
For example, you want to track the usage of each version of an antivirus application.
This option lets you determine how many users use the version. You create a
separate definition for each version of the application you want to meter and enter
the specific version in each rule.

■ You want to allow one version of an application to run but deny other versions.
This option lets you enforce the use of a certain version of an application. For
example, you can allow the version of an application that has a security fix while
blocking the use of other versions. You create two application metering policies. In
one policy, you create a rule for the approved version and set the policy to allow it
to run. In the other policy, you create a definition for each version that you want to
deny and set the policy to deny the applications.

File and product versions

When specifying application definitions, you can use wildcards to broaden the scope
of a definition. To use wildcards, place an * before and after a string.

For example, if you want to deny certain games from running, you can use a wildcard
to deny all applications from a game software company. Create a rule, and in the
Company name text box, type *company_name*.

Note: Be careful when using wildcards with Deny option - accidentally blocked system
files may affect system functionality.

Wildcards

The Command line text box contains the command line that the application must use
to be monitored. Include an * before and after the command-line text to ensure that
the entire command line is included.

Command line

Defining applications to meter or deny
Application metering and denial is only available on Windows computers.

When you configure an application metering policy, you define the applications you want to
meter by creating application definitions. For every metering policy, you can define one or
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more applications. To create application definitions, you specify a set of definition details for
each application.

Before you perform this step, ensure that you have prepared managed computers for metering.

See “Preparing managed computers for inventory and metering” on page 35.

To define applications to meter or deny

1 Open an application metering or blacklisting policy.

See “Metering applications using custom application metering policies” on page 117.

See “Denying applications using the predefined Blacklisted Applications policy” on page 127.

See “Denying applications using custom application metering policies” on page 128.

2 On the policy page, on the Software tab, click the Add drop-down list, and then do one
of the following:.

■ Click Rule, in the Add Application Rule dialog box, type the application definition
details, and then click OK.
In theAdd Application Rule dialog box, you can manually create your own application
definitions. The application definition detail fields are case-sensitive.
This method is useful for defining the software applications that are not already installed
on computers on your network. For example, you can deny applications such as games
or P2P file-sharing programs before they are ever used.

■ Click Software, in the Select Software dialog box, click the application that you want
to meter or deny, and then click OK.
In the Select Software dialog box, you can choose applications from a list of known
software programs that are defined in the Software Catalog. The list generally contains
the software that is already installed on computers on your network. The list may
contain multiple versions of the same application.
This method is useful to quickly include a known software application without manually
configuring application definition details. However, the known application definition
details may be too specific. For example, application definitions may be version-specific,
especially those using known software application details. If you use a known application
from the Software drop-down list, you may need to edit application definition details.

See “About defining applications to meter or deny” on page 119.

3 (Optional) To edit application definition details, do the following:

■ On the Software tab, click the application detail that you want to edit, and then click
the Edit symbol.

■ In the Add Application Rule dialog box, edit the application definition details, and
then click OK.
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4 Add all of the application definitions that you want to meter or deny using this policy.

5 Click Save changes.

About application metering start, stop, and denial events
Application metering is only available on Windows computers.

Inventory Solution provides the application metering policy option Record usage events that
lets you track the usage events of the applications that are defined in the policy.

When the Record usage events option is enabled, and a user of a managed computer starts
or stops a metered application, an event is generated. When a user tries to use a denied
application, a denial event is generated. Every start event has a stop event or becomes a
denial event. After the events are sent to the CMDB, you can generate reports to view this
data.

See “About software usage tracking, application metering, and application denial” on page 103.

See “Application summary data” on page 131.

Application Metering Plug-in sends the events to the CMDB in a batch at a specified interval
or every time the number of captured events reaches 10000.

If the Symantec Management Agent cannot connect to the CMDB, the managed computer
saves the information locally and sends it later.

If a managed computer terminates abnormally, then the next time it starts, Application Metering
Plug-in does the following:

■ Determines which applications were running when the computer was terminated

■ Generates the appropriate stop events

When you view a managed computer in the Resource Manager, you can view application
metering start and stop events data by clicking View > Events, and then expanding Data
Classes > Inventory > Application metering.

Table 8-4 Application metering start events data

ExampleDescriptionField

{018B191B-47AE-4180-9FCD-
7F3CEA4F1E12}

Resource guid that is generated by using
various attributes of a file. For example,
its internal name, manufacturer, version
etc.

FileResourceGUID

{493435F7-3B17-4C4C-B07F-
C23E7AB7781F}

Resource guid that is generated for a
specific user on a domain.

UserGuid

804Process ID of the application.PID

123Software usage tracking, application metering, and application denial
Metering applications



Table 8-4 Application metering start events data (continued)

ExampleDescriptionField

Microsoft WordName of the application metering policy.Policy Name

9/03/2012 9:51:18 A.M.Date and time of the event.Start Date

{CC1355B1-3993-4519-BB4C-
8C41735E3825}

The GUID of the policy that caused the
event to be generated.

Policy GUID

/nThe command-line options that are used
to start the application.

Command-line

0Specifies whether this event is a denial
event.

0 = not a denial event

1 = denial event

Denied

C:\Program Files\Microsoft
Office\Office\WINWORD.EXE

Path to the application file on the
managed computer.

File Path

6/7/2012 3:23:55 P.M.The time when the application is
launched on the managed computer.

Event Time

Table 8-5 Application metering stop events data

ExampleDescriptionField

804Process ID of the application.PID

Microsoft WordName of the application metering policy.Policy Name

9/03/2012 9:51:18 A.M.Date and time of the event.Start Date

188714The amount of time in seconds that the
application was used during the
monitoring period.

When the application is monitored, this
value is updated every 30 seconds.

Total Run Time

7921664Maximum amount of memory in bytes
used by the application during the
monitoring period. When the application
is monitored, this value is updated every
30 seconds.

Peak Memory
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Table 8-5 Application metering stop events data (continued)

ExampleDescriptionField

0.7652Average CPU usage by the application
during the monitoring period, where 100
equals 100 percent usage. When the
application is monitored, this value is
updated every 30 seconds.

Average CPU

6/7/2012 3:28:13 P.M.The time when the application is closed
on the managed computer.

Event Time

Denying applications
Application denial is only available on Windows computers.

To deny one or more applications from running, you configure the predefined Blacklisted
Applications policy or create custom application metering policies.

The application metering driver is installed on Windows client computers together with
Application Metering Plug-in. This driver monitors the running applications and blocks the ones
that are defined in the policy.

Once the driver is downloaded, Application Metering can block any processes that are defined
in the application denial policies. To avoid blocking important system software, Symantec
recommends that you use specify the application denial rules in greater detail and avoid using
the rules that are too general.

Note: On Windows XP client computers, the driver is not supported, and application metering
and denial works in the same way as in ITMS 7.6 and earlier.

When you configure an application metering policy, you define the applications you want to
deny by creating new or editing the existing application definitions.

See “About defining applications to meter or deny” on page 119.

When an application starts on a managed computer, the Application Metering Plug-in checks
for a turned on policy that monitors the application. If the plug-in finds the turned on policy, it
does the following:

■ Records the application summary data locally and sends this data to the Configuration
Management Database (CMDB) at the end of the application monitoring period.
See “Application summary data” on page 131.
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■ Sends the event notifications to the CMDB as specified in the application metering policy.
It can send application start, stop, or denial events. It sends this information in batches at
a specified interval or every time the number of captured events reaches 10000.
See “About application metering start, stop, and denial events” on page 123.

■ Denies the use of the application if the application metering policy so specifies.

Warning: Multiple application metering policies to monitor the same application. This may
cause incorrect data in reports or trigger duplicate notification policy actions.

See “About software usage tracking, application metering, and application denial” on page 103.

Table 8-6 Process for denying applications

DescriptionActionStep

Target computers must be managed with the Symantec Management
Agent and have Application Metering Plug-in installed.

See “Preparing managed computers for inventory and metering”
on page 35.

Prepare computers for
metering.

Step 1

You can configure the archiving and purging settings for gathered
application metering data.

See “Configuring the purging settings for application metering data”
on page 130.

Mail server and address settings should also be configured if you want
to send an email that reports the denied application event.

For more information see the topic about mail server and address
settings in the IT Management Suite Administration Guide.

(Optional) Configure settings
for gathered application
metering data and mail server
and address settings.

Step 2

To deny applications from running, you can use different options based
on your needs:

■ Configure the predefinedBlacklisted Applications policy. You can
add as many applications to this policy as you want.
See “Denying applications using the predefined Blacklisted
Applications policy” on page 127.

■ You can create and configure custom application metering polices
to meet your needs.
See “Denying applications using custom application metering
policies” on page 128.

Deny applications from
running on managed
computers.

Step 3

You can view metering data in application metering reports.

See “Viewing inventory data in reports” on page 143.

View application metering
results.

Step 4
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Denying applications using the predefined Blacklisted Applications
policy

Application denial is only available on Windows computers.

You can deny multiple applications from running on managed computers.

To deny applications from running, you configure the predefined Blacklisted Applications
policy. The Blacklisted Applications policy is turned on by default. You can add multiple
applications to this policy.

To add software applications to the Blacklisted Applications policy, do one of the following:

■ Define software applications on the Blacklisted Applications policy page.
The applications that you want to deny may or may not be installed and discovered on your
managed computers.
See “To deny software applications on the Blacklisted Applications policy page” on page 127.

■ Blacklist software applications.
The applications that you want to deny are already installed and discovered on your
managed computers.

When you deny any software component, the software component is scanned for an .exe file.
If that software component contains any .exe file, it is denied. A separate rule is created for
every .exe file.

This task is a step in the process for denying applications.

See “Denying applications” on page 125.

To deny software applications on the Blacklisted Applications policy page

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, expand Software > Application Metering > Blacklisted Applications.

3 On theBlacklisted Applications policy page, on the Software tab, define the applications
that you want to deny.

See “Defining applications to meter or deny” on page 121.

4 (Optional) On the policy page, on the Options tab, configure the policy options for the
denied applications according to your needs.

For example, you can configure the policy options in the following ways:

■ To record the deny events and send the records to the CMDB at least every week,
check Record usage events, and then, in the drop-down lists on the right, click Deny
and Weekly.
See “About application metering start, stop, and denial events” on page 123.
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■ To send an email that reports the deny events, in the drop-down list, click Send an
email, in theMail Settings dialog box, enter the recipient's email address in the E-mail
ID field, type a subject and text for the email, and then click OK.

■ To prompt a user with a message when the user attempts to start a denied application,
check Inform user and type the text of the message.
In the drop-down list next to the Inform user box, you can choose whether to use a
default message, or a custom message. You cannot edit the text of the default message.
The custom message is displayed exactly the way you enter it.

5 Click Save changes.

To deny software applications in the Software view

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In the Software pane, click Favorites > Discovered Unreviewed Software.

3 In the content pane, select the application that you want to add to the Blacklisted
Applications policy, and then click Actions > Blacklist Application.

If the software component is successfully added to the Blacklisted Applications policy,
the following message is displayed:

“The following software has been successfully marked as blacklisted.”

If the software component cannot be denied, the following message is displayed:

“The following software cannot be blacklisted because it is not associated with any
executable files.”

Denying applications using custom application metering policies
Application denial is only available on Windows computers.

To deny applications from running, you can create and configure policies that run denying
functions on managed computers. You can define one or more applications in one policy.

To deny several applications, you can also add them to the Blacklisted Applications policy.
This policy is a predefined policy that denies applications from running.

See “Denying applications using the predefined Blacklisted Applications policy” on page 127.

To use application metering, you must have Application Metering Plug-in installed on target
computers.

This task is a step in the process for denying applications.

See “Denying applications” on page 125.
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To deny applications using custom application metering policies

1 In the Symantec Management Console, on the Manage menu, click Policies.

2 In the left pane, expand Software > Application metering.

3 Right-click theApplicationmetering folder and clickNew >Applicationmetering policy.

4 On the policy page, give the policy a unique name and description.

5 On the Software tab, select or define the applications you want to meter.

See “Defining applications to meter or deny” on page 121.

You can also edit application definitions or delete applications from the list.

6 On the Options tab, configure the policy options as follows:

■ To configure if and when the applications in this policy can run, click Only deny
running, or Deny from running.
For example, to deny an application from running during business hours, click Only
deny running, in the drop-down list, click During business hours and weekends,
and then configure business hours and days according to your needs.

■ To track the usage events of the applications that are defined in the policy, check
Record usage events, and then, in the drop-down lists on the right, specify the event
types that you want to record and the intervals when the records of events are sent to
the Configuration Management Database (CMDB).
For example, to record the deny events and send the records to the CMDB at least
every day, check Record usage events, and then, in the drop-down lists on the right,
click Deny and Daily.

Note:Captured events may be sent more frequently than the specified interval. Sending
events is forced as soon as 10000 events are collected.

See “About application metering start, stop, and denial events” on page 123.

■ To define the actions to be taken when a denied application attempts to run, under If
run attempted during deny hours, in the drop-down list below, click No action or
Send an email.
For example, to send an email that reports the denied application event, in the
drop-down list, click Send an email, in theMail Settings dialog box, type the recipient's
email address in the E-mail ID field, type a subject and text for the email, and then
click OK.

■ To prompt a user with a message when the user attempts to start a denied application,
check Inform user, and type the text of the message.
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In the drop-down list next to the Inform user box, you can choose whether to use a
default message, or a custom message. You cannot edit the text of the default message.
The custom message is displayed exactly the way you enter it.

7 Click Apply to, and select the resources to which you want to apply the policy.

For more information, see the topics about specifying the targets of a policy and specifying
filtering rules in the IT Management Suite Administration Guide.

8 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

9 Click Save changes.

Configuring the purging settings for application
metering data

Software-based usage tracking is only available on Windows and Mac computers.

Application metering and denying is only available on Windows computers.

Application metering data is stored on metered computers and then sent to the CMDB. Over
time, you may want to delete (purge) application metering data. You can purge metering events
and summary data. You can also configure the settings that purge the data at configured time
intervals.

By default, application metering data that is older that two months is deleted.

See “Application summary data” on page 131.

This task is a step in the following processes:

■ Tracking usage of the managed software products

■ Metering and denying applications

See “Software usage tracking” on page 105.

See “Metering applications” on page 115.

To configure the purging settings for application metering data

1 In the Symantec Management Console, on the Settings menu, click All Settings.

2 In the left pane, under Settings, expandDiscovery and Inventory > Inventory Solution,
and then click Application Metering Configuration.

3 On the Application Metering Configuration page, you can do the following:

■ To purge events, check the Purge events older than box, type the number of days,
and then click Purge Events Now.
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■ To purge summary data, in the Purge summary data older than box, type the number
of months, and then click Purge Data Now.

4 Click Save changes.

Application summary data
Software-based usage tracking is only available on Windows and Mac computers.

Application metering and denying is only available on Windows computers.

Each time a metered application starts, Application Metering Plug-in records application
summary data. This data is stored on the managed computer and sent to the CMDB at the
end of the application monitoring period. If any data was sent during the monitoring period, it
is replaced at the end of the monitoring period.

Application summary data is sent to the CMDB in batches daily by default for the following
types of applications:

■ Windows and Mac applications that are associated to the software components of the
software products, for which the software-based usage tracking option is enabled.
For Windows applications, you can view this data in the Executable Usage report.
For Windows and Mac managed software products, you can view this data in the
Underutilized Software report.

■ Windows applications that are defined and marked as allowed or denied in a turned on
application metering policy.
You can view this data in the Executable Usage report.

See “Viewing inventory data in reports” on page 143.

On Windows computers, to prevent an overload to the system when this data is sent, the data
is randomly sent over an interval of time. A value in the
HKEY_LOCAL_MACHINE\SOFTWARE\Altiris\Application Metering registry key on each
managed computer determines the length of the interval. The name of the value is Fuzzy
Factor, and it is set to 10 by default. This value specifies the time interval when the data can
be sent as a percentage of the total batch creation time. To change the length of this time
interval, you must change the value of this registry key on each managed computer.

For example, the data is sent to the CMDB every seven days (168 hours) and the Fuzzy Factor
value is 10. Then the length of the interval is 10% of seven days or about 17 hours. Half of
this interval precedes the specified send time and half of it follows. Thus the time interval in
which the data is sent would start after about 159 hours and end after 177 hours.

Application metering records data for each metered application in the order in which it is stored
in the data file.

See “Configuring the purging settings for application metering data” on page 130.
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Table 8-7 Application summary data for Windows applications

ExampleDescriptionField

{018B191B-47AE-4180-9FCD-
7F3CEA4F1E12}

Resource guid that is generated by using
various attributes of a file. For example,
its internal name, manufacturer, version
etc.

FileResourceGUID

{493435F7-3B17-4C4C-B07F-
C23E7AB7781F}

Resource guid that is generated for a
specific user on a domain.

User Guid

11/13/2012 8:38:18 A.M.The date when the application was last
started.

Last Start

September 2012Month and year of the monitoring period.Month Year

3Number of times the application was
started during the monitoring period.

Run Count

1Number of times the use of the
application was denied during the
monitoring period.

Denial Count

188714Total amount of time in seconds that the
application was used during the
monitoring period

When the application is monitored, this
value is updated every 30 seconds.

Total Run Time

7921664Maximum amount of memory in bytes
used by the application during the
monitoring period. When the application
is monitored, this value is updated every
30 seconds.

Peak Memory

0.7652Average CPU usage by the application
during the monitoring period, where 100
equals 100 percent usage. When the
application is monitored, this value is
updated every 30 seconds.

Average CPU

0Specifies whether the current set of
application summary data is the final set
for the month.

0 (or false) = not the final data

1 (or true) = the final data

Month End
Summary
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Table 8-8 Application summary data for Mac applications

ExampleDescriptionField

{591a0b47-3855-443a-91f2-445c54114d89}Resource guid that is generated for
specific Software Product in the CMDB.

ProductGuid

{924c1059-8a3f-4b56-a595-6a766fadfe3c}Resource guid that is generated for a
specific user.

UserGuid

5/24/2017 2:48:37 PMThe date when the application was last
used.

Last Start
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Gathering baseline
inventory

This chapter includes the following topics:

■ About baseline inventory

■ Gathering baseline inventory

About baseline inventory
This type of inventory is only available for Windows computers.

Baseline inventory lets you track and compare the changes in files and registry keys on
managed computers. You generate a baseline that identifies the files or registry settings of a
computer. You can later run the compliance scans on your managed computers to compare
their current files or registry keys with those in the baseline. The differences between the
baseline scan and compliance scan data are reported to the Configuration Management
Database (CMDB).

Baseline inventory reports newly added files, missing files, and registry keys. It also reports
duplicate files and indicates if the files have the same version or a different version.

You can use the baseline inventory for the following purposes:

■ Track the files and registries that deviate from the corporate standards.

■ Verify the accuracy of rollouts and upgrades.

■ View a compliance level summary of the computer and reports of the changes in a file.

■ Automatically notify system administrators or the help desk when a computer is
non-compliant.

Baseline inventory uses standard tasks to perform the baseline scan and compliance scan.
You can view reports to track baseline and compliance scan information.
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The baseline inventory is the same for file and registry baselines. However, the configuration
files, snapshot files, and tasks differ. The baseline configuration file contains the options that
determine the files or registry settings to scan. You can use the default configuration file, edit
it, or create one or more custom configuration files.

See “About baseline files” on page 136.

Compliance scan compares the current files or registry keys on one or more computers with
the baseline snapshot (.BLS) files. The differences between the baseline and the compliance
scans are written to an output file on the scanned computer and reported to the CMDB.

The baseline scan captures the current files or registry keys settings on a computer. It also
compiles a baseline snapshot file which is used during the compliance scan.

The baseline scan and the compliance scan report information about the scanned computers
and the scan results. You can use notification tasks to automatically notify the system
administrator or the help desk when certain events occur. This feature helps you prevent the
system failures that might occur when a computer becomes non-compliant.

See “Gathering baseline inventory” on page 135.

Gathering baseline inventory
This type of inventory is only available for Windows computers.

Baseline inventory lets you track and compare the changes in files and registry keys on
managed computers. You generate a baseline that identifies the files or registry settings of a
computer. You can later run the compliance scans on your managed computers to compare
their current files or registry keys with those in the baseline. The differences between the
baseline scan and compliance scan data are reported to the Configuration Management
Database (CMDB).

See “About baseline inventory” on page 134.

Table 9-1 Process for gathering baseline inventory

DescriptionActionStep

Target computers must be managed with Symantec
Management Agent.

See “Preparing managed computers for inventory
and metering” on page 35.

Prepare computers for gathering
baseline inventory.

Step 1
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Table 9-1 Process for gathering baseline inventory (continued)

DescriptionActionStep

A file baseline task lets you perform the file baseline
scan and generate a baseline that identifies the files
of a computer.

See “Running a file baseline or file compliance task”
on page 137.

A registry baseline task lets you perform the registry
baseline scan and generate a baseline that identifies
the registry settings of a computer.

See “Running a registry baseline or registry
compliance task” on page 139.

Create and run a file or registry
baseline task.

Step 2

A file compliance task lets you perform the file
compliance scan on your managed computers to
compare their current files with those in the baseline.

See “Running a file baseline or file compliance task”
on page 137.

A registry compliance task lets you perform the
registry compliance scan on your managed
computers to compare their current registry settings
with those in the baseline.

See “Running a registry baseline or registry
compliance task” on page 139.

Create and run a file or registry
compliance task.

Step 3

You can view baseline inventory data in Baseline
Reports.

See “Viewing inventory data in reports” on page 143.

View baseline inventory results.Step 4

About baseline files
Baseline inventory is only available for Windows computers.

The baseline inventory process uses and creates several baseline files. A baseline configuration
file contains options for running the scans. For example, you configure the files or registry keys
to be included or excluded, the directories to scan, and so on. You can use the default
configuration file, edit it, or create one or more custom configuration files. Configuration files
for registry baselines are in INI format. The default registry baseline configuration file is
AexRegScan.ini. Configuration files for file baselines are in INI format but have a .bls extension.
The default file baseline configuration file is local_master.bls.

The local baseline tasks use the default configuration files.
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See “About baseline inventory” on page 134.

The location of the default baseline configuration files and additional sample configuration files
is as follows:

InstallDir\Altiris\Notification Server\NSCap\bin\Win32\X86\Inventory\Application

Management

A baseline snapshot (BLS) file maintains a record of the files or registry settings on a computer
at a given time. This data is gathered during a baseline scan that is based on the options in a
baseline configuration file. Registry baseline snapshots are saved to a new file on the scanned
computer in .RBL format.

File baseline snapshots are appended to the baseline configuration file. The location of the
default baseline snapshot files is as follows:

%ProgramFiles%\Altiris\eXpress\Baseline

The file compliance scan and the registry compliance scan create output in XML format. This
output is stored in Notification Server Events (NSEs) and reported to the Configuration
Management Database (CMDB).

The default locations of the file baseline tasks and the registry baseline tasks, respectively,
are as follows:

InstallDir\Altiris\Notification Server\NSCap\bin\Win32\X86\Inventory\Application

Management\FileBaselinePackage

InstallDir\Altiris\Notification Server\NSCap\bin\Win32\X86\Inventory\Application

Management\RegBaselinePackage

Warning: If you want to run a baseline task with custom configuration or snapshot after an
offbox upgrade, you need to update the path to the configuration and snapshot files. After an
upgrade, the host name of Notification Server may change, the path to the task files becomes
invalid for the new server, and the baseline task with custom configuration or snapshot fails.
If you define the UNC path to the task files using\\localhost\NSCap\..., the path defined
before the upgrade remains valid after the upgrade.

You need to make sure that you copy or keep the baseline configurations and baseline
snapshots that you want to use for compiling a custom baseline or comparing with a custom
baseline when running these tasks. Otherwise, the task fails.

Running a file baseline or file compliance task
File baseline and file compliance tasks are only available for Windows computers.
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A file baseline task lets you perform the file baseline scan and gather data about the files on
a computer at a given time. The data that is gathered during this scan is saved in a baseline
snapshot (.BLS) file on the scanned computer.

A file compliance task lets you perform the file compliance scan. The files that are found during
this scan of your managed computers are compared to the baseline snapshot. Baseline
inventory also contains predefined reports to track baseline and compliance information.

To perform a file baseline scan, you create and run a File Baseline task. Symantec
recommends that you run the file baseline task once to establish the baseline, and then re-run
the file baseline task only when the standard configuration changes.

You should not run the file baseline task on a regular basis if the file baseline task and the file
compliance task run on the same computer. If you do, you continually overwrite the file baseline
snapshot file.

This task is a step in the process for gathering baseline inventory.

See “Gathering baseline inventory” on page 135.

Before you perform this step, ensure that you have prepared the managed computers for
gathering baseline inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To run a file baseline or file compliance task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, navigate to the folder where you want to create and run a file baseline
task or a file compliance task, right-click the folder, and then click New > Task.

For example, to create the task in the Inventory folder, expand Jobs and Tasks > System
Jobs and Tasks > Discovery and Inventory, right-click Inventory, and then click New
> Task.

3 In the Create New Task dialog box, in the left pane, under Discovery and Inventory,
click File Baseline.

4 In the right pane, do one of the following:

■ To configure the file baseline task, click Compile a baseline snapshot.

■ To configure the file compliance task, click Compare with a baseline snapshot.

For more information about the options, click the page and then press F1.

5 Click OK.

6 On the File Baseline task page, under Task Status, configure the task schedule.

For more information, see the topic about adding a schedule to a policy, task, or job in
the IT Management Suite Administration Guide.

7 Click Save changes.
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To run a custom file baseline or file compliance task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, navigate to the folder where you want to create and run a file baseline
task or a file compliance task, right-click the folder, and then click New > Task.

For example, to create a task in the Inventory folder, expand Jobs and Tasks > System
Jobs and Tasks > Discovery and Inventory, right-click Inventory, and then click New
> Task.

3 In the Create New Task dialog box, in the left pane, under Discovery and Inventory,
click File Baseline.

4 In the right pane, do one of the following:

■ To customize the baseline configuration, select Compile a baseline snapshot, and
then select Use custom baseline configuration.
Click Create a baseline configuration with File Baseline Configuration Editor. In
the File Configuration Editor, configure the parameters for the baseline, and then
save the .bls file and close the editor dialog box.
Click Browse. In the dialog box that opens, navigate to the .bls file that you created,
select the file, and then click Open.

■ To customize the compliance task, select Compare with a baseline snapshot, and
then select Compare with custom baseline snapshot.
(Optional) Click Open File Baseline Snapshot Editor. In the File Snapshot Editor,
configure the parameters for the snapshot, and then save the .bls file and close the
editor dialog box.
Click Browse. In the dialog box that opens, navigate to the snapshot that you want to
use, select the file, and then click Open.

5 (Optional) ClickAdvanced, and then, in the dialog box that opens, configure the download,
run, and task setting.

Click OK.

6 Click OK.

The next step is to wait for the client computers to receive the new task and report the results,
and then view the data that is stored in the Configuration Management Database (CMDB).

See “Viewing inventory data in reports” on page 143.

Running a registry baseline or registry compliance task
Registry baseline and registry compliance tasks are only available for Windows computers.
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A registry baseline task lets you perform the registry baseline scan and gather data about the
registry settings on a computer at a given time. The data that is gathered during this scan is
saved in a registry baseline snapshot file (.RBL) on the scanned computer.

A registry compliance task lets you perform the registry compliance scan. The registry settings
that are found during this scan of your managed computers are compared to the baseline
snapshot.

To perform a registry baseline scan, you create and run a Registry Baseline task. Symantec
recommends that you run each registry baseline task once to establish the baseline, and then
run the registry baseline task only when the computer configuration changes.

You should not run the registry baseline task on a regular basis if the registry baseline task
and the compliance task run on the same computer. If you do, you continually overwrite the
baseline snapshot file.

This task is a step in the process for gathering baseline inventory.

See “Gathering baseline inventory” on page 135.

Before you perform this step, ensure that you have prepared the managed computers for
gathering baseline inventory.

See “Preparing managed computers for inventory and metering” on page 35.

To run a registry baseline or registry compliance task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

2 In the left pane, navigate to the folder where you want to create and run a registry baseline
task or a registry compliance task, right-click the folder, and then clickNew > Task.

For example, to create the task in the Inventory folder, expand Jobs and Tasks > System
Jobs and Tasks > Discovery and Inventory, right-click Inventory, and then click New
> Task.

3 In the Create New Task dialog box, in the left pane, under Discovery and Inventory,
click Registry Baseline.

4 In the right pane, do one of the following:

■ To configure the registry baseline task, click Compile a baseline snapshot.

■ To configure the registry compliance task, click Compare with a baseline snapshot.

For more information about the options, click the page and then press F1.

5 Click OK.

6 On the Registry Baseline task page, under Task Status, configure the task schedule.

For more information, see the topic about adding a schedule to a policy, task, or job in
the IT Management Suite Administration Guide.

7 Click Save changes.
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To run a custom registry baseline or registry compliance task

1 In the Symantec Management Console, on the Manage menu, click Jobs and Tasks.

In the left pane, navigate to the folder where you want to create a registry baseline task
or a registry compliance task, right-click the folder, and then click New > Task.

For example, to create a task in the Inventory folder, expand Jobs and tasks > System
Jobs and Tasks > Discovery and Inventory, right-click Inventory, and then click New
> Task.

2 In the Create New Task dialog box, in the left pane, under Discovery and Inventory,
click Registry Baseline.

3 In the right pane, do one of the following:

■ To customize the baseline configuration, select Compile a baseline snapshot, and
then select Use custom baseline configuration.
ClickCreate a registry configuration with Registry Baseline Configuration Editor.
In the Registry Configuration Editor, configure the parameters for the registry, and
then save the .ini file and close the editor dialog box.
Click Browse. In the dialog box that opens, navigate to the .ini file that you created,
select the file, and then click Open.

■ To customize the compliance task, select Compare with a baseline snapshot, and
then select Compare with custom baseline snapshot.
(Optional) ClickOpen Registry Baseline Snapshot Editor. In theRegistry Snapshot
Editor, configure the parameters for the snapshot, and then click OK.
Under Baseline configuration, click Browse. In the dialog box that opens, navigate
to the baseline configuration file that you want to use, select the file, and then click
Open.
Under Baseline snapshot, click Browse. In the dialog box that opens, navigate to
the snapshot that you want to use, select the file, and then click Open.

4 (Optional) ClickAdvanced, and then, in the dialog box that opens, configure the download,
run, and task settings.

Click OK.

5 Click OK.

The next step is to wait for the client computers to receive the new task and report the results,
and then view the data that is stored in the Configuration Management Database (CMDB).

See “Viewing inventory data in reports” on page 143.
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Viewing inventory data and
reports

This chapter includes the following topics:

■ About viewing inventory data

■ Viewing inventory data in reports

■ About viewing inventory data in the Resource Manager

■ Viewing inventory data in the Resource Manager

■ Viewing inventory data in Computers and Software views

About viewing inventory data
The inventory data is stored in the Configuration Management Database (CMDB).

You can use the following functions of the Symantec Management Platform to view the
information in the CMDB:

■ Inventory and application metering reports
See “Viewing inventory data in reports” on page 143.

■ The Resource Manager
See “About viewing inventory data in the Resource Manager” on page 144.

You can manage software products, track software usage, and view inventory data in the
Computers and Software views. You see the views if you install the following:

■ Symantec Management Platform

■ Inventory Solution

■ Software Management Solution
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■ ITMS Management Views

See “Viewing inventory data in Computers and Software views” on page 146.

Viewing inventory data in reports
You can view a number of predefined reports or you can create custom reports according to
your needs.

For more information, see the topics about creating and modifying custom reports in the IT
Management Suite Administration Guide.

See “About viewing inventory data” on page 142.

Most reports let you filter the information that you view. For example, there is an inventory
report that lists computers with their BIOS information. You can view the BIOS manufacturer,
version, and release date. You can also filter the report to view the computers in a certain
domain. You can also filter the list of computers by using wildcards.

For more information, see the topics about using reports in the IT Management Suite
Administration Guide.

This task is a step in the following processes:

■ Gathering inventory on managed computers
See “Gathering inventory on managed computers” on page 40.

■ Gathering inventory using stand-alone packages
See “Gathering inventory using stand-alone packages” on page 57.

■ Gathering software inventory
See “Gathering software inventory” on page 87.

■ Tracking usage of the managed software products
See “Software usage tracking” on page 105.

■ Metering and denying applications
See “Metering applications” on page 115.

■ Gathering baseline inventory
See “Gathering baseline inventory” on page 135.

To view inventory data in reports

1 In the Symantec Management Console, on the Reports menu, click All Reports.

2 In the left pane, under Reports, expand Discovery and Inventory > Inventory.

To view usage tracking or application metering reports, in the left pane, under Reports,
expand Software > Application Metering.

3 Browse the report categories and select the report that you want to view.
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About viewing inventory data in the Resource
Manager

You can use the Resource Manager to view all of the inventory data for a single resource. You
can view the basic inventory, for example, the computer's IP address. You can also view more
detailed data that the Inventory Solution gathers. For example, you can quickly view which
operating system a certain computer is running. You can also view the status of that inventory
data, such as when the data was last gathered. You also use the Resource Manager to view
custom inventory data.

For more information, see the topics about using the Resource Manager in the IT Management
Suite Administration Guide.

You can view the content of the actual data classes or you can view hardware and software
data summaries.

See “About viewing inventory data” on page 142.

See “Viewing inventory data in the Resource Manager” on page 145.

The hardware summary page displays the following sections depending on the gathered
inventory data:

Table 10-1 Hardware inventory summary page

DescriptionSection

This section lists the agents that are installed on the resource, the version
number, the date they were first discovered, the date when the last
inventory was collected, etc.

Agent

This section lists the detailed information about the hardware that the
resource uses, for example, processor type and speed, number of cores,
RAM size, chassis type, etc.

Hardware

This section contains the details about the drives that the resource uses,
for example, the drive name, type, capacity, etc.

Drives

This section displays the installed applications and their details such as
the version, the date they were installed, etc.

Installed Software

This section contains the details such as GUID, users, group, and primary
user.

User Group

The software summary page includes the following sections:
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Table 10-2 Software inventory summary page

DescriptionSection

This section displays the installed applications and their details such as
the version, the date they were installed, and so on.

Installed Software

This section lists the programs that are in the Add Remove Programs of
the Control Panel of the computer. It lists the name of the programs, their
version number, the date they were installed, the manufacture type,
estimated size, and so on.

Add Remove Program

This section lists all the files that are associated with the software
component installed on the computer. It displays details such as the file
version, name, size, path, and so on.

Installed File Details

Viewing inventory data in the Resource Manager
You can view all of the inventory data for a single resource in the Resource Manager.

For more information, see the topics about resource management in the IT Management Suite
Administration Guide.

See “About viewing inventory data” on page 142.

See “About viewing inventory data in the Resource Manager” on page 144.

This task is a step in the following processes:

■ Gathering inventory on managed computers
See “Gathering inventory on managed computers” on page 40.

■ Gathering inventory using stand-alone packages
See “Gathering inventory using stand-alone packages” on page 57.

■ Gathering custom inventory
See “Gathering custom inventory” on page 78.

■ Gathering software inventory
See “Gathering software inventory” on page 87.

To view the inventory data for a computer in the Resource Manager

1 In the Symantec Management Console, on the Manage menu, click Computers.

2 In the left pane, expand Computer Views and Groups, and then click All Computers.
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3 In the content pane (center), right-click a computer, and then click Resource Manager.

You can use the Search box to search the computers by name. You can also use the
logical operators AND, OR ad NOT.

For more information about the options in the Computers view, click the page, and then
press F1.

4 To view the hardware summary, on the Resource Manager page, click Summaries >
Hardware Summary.

To view the software summary, on the Resource Manager page, click Summaries >
Software Summary.

To view the Installed Software by Computer Report, on the Resource Manager page,
in the left pane, click More actions, and then click Installed Software by Computer
Report.

To view the inventory data for a data class in the Resource Manager

1 In the Resource Manager, on the View menu, click Inventory.

2 In the central pane, select the data class.

3 In the right pane, select the tab that contains the information you want to view.

Viewing inventory data in Computers and Software
views

Symantec Management Console views let you view inventory data about computers, users,
operating systems, and installed software products in your environment.

See “About viewing inventory data” on page 142.

This task is a step in the following processes:

■ Gathering inventory on managed computers
See “Gathering inventory on managed computers” on page 40.

■ Gathering inventory using stand-alone packages
See “Gathering inventory using stand-alone packages” on page 57.

■ Gathering software inventory
See “Gathering software inventory” on page 87.

■ Tracking usage of the managed software products
See “Software usage tracking” on page 105.
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To view inventory data in the Computers View

1 In the Symantec Management Console, on the Manage menu, click Computers.

2 In the left pane, expandComputer Views and Groups, and then select the organizational
view and group that you want to view.

For example, to view virtual machines, expand All Computers > Virtual Machine.

3 In the navigation pane, click a computer that you want to view.

4 In the right pane, in the top section, navigate through a flipbook. Do one of the following:

■ To select the type of data that you want to view, click the flipbook title.

■ To navigate through the flipbook, click the links on either side of the title.

5 To view the software information, expand Software.

To view software inventory and usage tracking data in the Software View

1 In the Symantec Management Console, on the Manage menu, click Software.

2 In left pane, under Software, select the type of information that you want to view.

For example, to view usage tracking information for software, click Metered Software >
Usage Tracking.

3 In the navigation pane, click the software product that you want to view.

4 In the right pane, in the top section, navigate through a flipbook. Do one of the following:

■ To select the type of data that you want to view, click the flipbook title.

■ To navigate through the flipbook, click the links on either side of the title.

5 To view the computer information, expand Computers with software installed.
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agent log A record of actions and events that take place on a computer on which Symantec
Management Agent is installed.

agent-based inventory A type of inventory that is gathered on the client computers that have Symantec
Management Agent installed on them.

agentless inventory A type of inventory that is gathered on the network devices and client computers
that do not have Symantec Management Agent installed on them.

Agentless Inventory

wizard

A tool that lets the user create agentless inventory tasks.

application metering A process of monitoring the usage of applications on the client computer at file
level. This process only runs on Windows client computers.

Application Metering

plug-in

The software that performs application metering and communicates with the Altiris
Agent.

application summary

data

The data that is recorded in the process of application metering. This data is stored
on the client computers and sent to CMDB (Configuration Management Database)
at the end of the application metering period.

baseline A file that is generated in the process of baseline inventory. Baseline identifies the
files or registry settings of a computer.

baseline inventory A type of inventory that allows to track and compare the changes in files and registry
keys on client computers. Baseline inventory reports newly added files, missing
files, and registry keys.

basic inventory A type of inventory that is gathered automatically when Symantec Management
Agent is installed on client computers, as part of the core Agent functionality. Basic
inventory data includes data such as computer name, domain, operating system,
etc.

CEM (Cloud-enabled

Management)

A feature that lets the user manage the client computers outside the corporate
network without a VPN (virtual private network).

client computer A computer on which Symantec Management Agent is installed, and which can be
managed from the Notification Server computer through Symantec Management
Console.

CMDB (Configuration

ManagementDatabase)

The central database that stores all the data that Symantec Management Platform
uses and generates.
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compliance scan A process that compares the current files or registry keys on a client computer with
the data in the baseline.

connection profile A group of settings that defines which network protocols are used to communicate
with the network devices.

custom data class A data class that has been configured to gather the specific type of inventory data.

custom inventory A type of inventory process that a user creates, and that gathers specific types of
the data that are not gathered with default inventory settings.

custom report An account of the gathered inventory information that has been configured to display
the inventory information of a particular kind.

data class A table in the CMDB (Configuration Management Database). Each data class has
a set of attributes that define its properties.

data class GUID A unique identifier of a data class. Every time a new data class is created or an
existing data class is edited, a new GUID is assigned to this data class.

delta inventory A type of inventory for which only the data that has changed since the last full
inventory scan is reported.

delta.cache A file in which the inventory data is recorded before it is sent to Notification Server.
The data that is recorded in delta.cache is compared to the results of the next
inventory scan. This file is specific to Inventory Solution for UNIX, Linux, and Mac.

event time The time when an application is launched on a client computer.

file baseline snapshot A file that captures a record of the files on a computer at a given time.

file baseline task A task that generates a baseline snapshot that identifies the files of a computer.

file compliance task A task that runs a compliance scan. The files that are found during this scan on the
client computers are compared to the baseline snapshot.

file path The path to an application file on a client computer.

file resource GUID A resource GUID that is generated by using various attributes of a file.

filescan.rule file A file that contains the information about different applications. Filescan.rule file is
used to detect the applications that are installed on the client computers. This file
is specific to Inventory Solution for UNIX, Linux, and Mac.

full inventory A type of inventory scan that collects the information about hardware and operating
system, software, and file properties of a client computer. The information is sent
to Notification Server.

Inventory andAgentless

Inventory home page

A portal page that provides links to the commonly used policies and tasks, and a
summary of inventory data.

Inventory for Network

Devices

A type of inventory that is gathered on the discovered devices in the network.
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Inventory Pack for

Servers

A separate product that gathers inventory on servers. This product runs on top of
Inventory Solution and uses the Inventory Pack for Servers Plug-in. Inventory Pack
for Servers uses a separate license.

Inventory Plug-in A plug-in that is used to to gather inventory data on client computers.

inventory policy An assignment that runs on client computers to gather a particular type of inventory
and report the results to the CMDB (Configuration Management Database).
Symantec recommends that you use policies for recurring activities.

Inventory portal page A page in the Symantec Management Console that provides links to the commonly
used inventory tasks, inventory data summary, and the statuses of inventory policies.

inventory report An account of the inventory data that an inventory policy or task gathers.

inventory task An assignment that runs on client computers to gather particular kind of information
or perform a particular action. Symantec recommends that you use tasks for singular
activities.

inventory verbose

logging

A feature that allows the logging of the trace messages. The logs are stored on the
client computers.

maintenance window A scheduled period of time when maintenance operations may be performed on a
client computer.

managed computer A computer on which the Symantec Management Agent is installed. Another term
for a client computer.

managed software

product

A software product that is listed in the Software Catalog. A managed software
product must have at least one software component associated to it. The software
components can be associated to software products automatically or manually.

network device A device in the network that exists as a resource in the CMDB (Configuration
Management Database) but is not managed by Symantec Management Agent.

Network Discovery A process of discovering all IP devices that are connected to a network.

NS.Nightly schedule to

associate Software

A predefined task that automatically associates new software components with the
relevant software products and populates the Software Catalog.

component to software

product task

NSE (NotificationServer

Event)

An XML file that is transferred between Notification Server and Symantec
Management Agent. NSE can contain the following information: event processing,
basic or full inventory, success or failure of a package download.

policy GUID The GUID of the policy that caused an event to be generated.

registry baseline

snapshot

A file that maintains a record of the registry settings on a computer at a given time.
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registry baseline task A task that generates a baseline snapshot that identifies the registry settings of a
computer.

registry compliance

task

A task that runs a compliance scan. The registry settings that are found during this
scan on the client computers are compared to the baseline snapshot.

server inventory A type of inventory that gathers inventory data about server-class software that is
installed on servers.

SNMP data mapping A process of establishing data relationships between the SNMP devices and the
data that needs to be gathered.

SNMP data mapping

table

The table that allows to define how to map SNMP devices to the data that is to be
gathered.

Software Catalog A catalog that contains a list of known applications and predefined software products.
Software Catalog is regularly updated to include the new inventory data.

Software Catalog Data

Provider

A component of Inventory Solution that is used to import software inventory data
into the Software Catalog. It provides a list of known applications and predefined
software products that is imported into the CMDB (Configuration Management
Database).

SoftwareDiscovery scan A process of gathering information about the software applications that are installed
on the client computers.

software inventory A type of inventory that gathers data about the applications that are installed on
the client computers.

software-based usage

tracking

The process of tracking the usage of the managed software at the software product,
component, and version level. This process only runs on Windows computers.

standalone inventory A type of inventory that is gathered on the client computers that don't have Symantec
Management Agent installed on them. The inventory is gathered through an
executable that runs on the target computer. This type of inventory only runs on
Windows computers.

standalone inventory

package

An executable file that is created from the Symantec Management Console, and
then runs on the client computers to gather inventory data.

targeted software

inventory

A type of inventory that determines whether a specific software is installed on the
client computers. This type of inventory only runs on Windows computers.

throttling A feature that is used to randomize the time when the inventory scan starts. When
throttling is enabled, the inventory scan goes to sleep immediately after it starts,
and then wakes up at a random time within the specified time period to complete
the scan.

unmanaged computer A computer that does not have Symantec Management Agent installed on it.

user GUID A resource GUID that is generated for a specific user on a domain.
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user initiated Inventory A type of inventory that the administrator initiates through the command prompt
using the XML files that belong to the already completed inventory policies or tasks.
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